
NOTICE OF MEETING - COMMISSIONERS C J T 18 Am 8: 45

RAINS COUNTY, TEXAS

Notice is hereby given that a REGULAR MEETING of the Rains County Commissioners

Court will be held at 10: 00 a. m. on July 24, 2025, in the Rains County Courthouse Courtroom.
Commissioner' s Court is open to the public. The subjects to be discussed or considered or

upon which any formal action may be taken are as follows:

CALL MEETING TO ORDER, PLEDGES OF ALLEGIANCE &

INVOCATION

II.       PUBLIC TESTIMONY   —   Citizens are invited to address the

Commissioners Court on topics not already scheduled for a Public

Hearing.  Speakers are limited to 5 minutes and should conduct

themselves in a civil manner.  The Commissioners Court cannot take

action on items not listed on the agenda in accordance with the Texas

Open Meetings Act.  Concerns may be addressed by County Staff, and

may be placed on a future agenda or addressed by some other course of
response.

III.      PRESENTATIONS

IV.      ITEMS FOR ACTION

A. CONSENT CALENDAR— All items listed are considered to be routine

by the Commissioner' s Court and will be enacted by one motion.

1.  Road and Bridge Reports

2.  Permits and Right- of-Way
3.  Environmental Enforcement and Emergency Management
4.  Grant Development

5.  Courthouse Security
6.  Approving minutes of prior Regular and or Special meeting

B. ACTION ITEMS— Discuss and possibly take action on the following:

1.  Approval of accounts payable.
2.  Approval of line- item transfers.

3.  Approval of budget amendments.

4.  Approval of payroll and personnel.
5.  Road and Bridge request a transfer of$ 75, 000 to cover the

culverts purchases, flex base and the 3" overlay of Type D cold



f'



mix to Upgrade . 73 of a mile on CR 1325 and transfer the funds

to the Road Material line 01 0- 1 1 50- 52320.

6.  Onsite Sewage Audit and Proposed organization of Department.

7.  Quote for camaras in the County Annex Courtroom.
8.  Termination of copier maintenance contract between Hilliard

Office Solutions LTC and Rains County.
9.  Courthouse repair bid.

10. Guardian System, a software system for the Jail.

11. Consider purchase of Automated External Defibrillators (AED)

for county buildings.

12. Consider action on adopting a Fraud, Waste, and Abuse policy.

ADJOURN TO EXECUTIVE SESSION AS NEEDED

V.       EXECUTIVE SESSIONS

As permitted by Texas Government Code §551. 071 ( 1) and (2),
Consultation with Attorney; §551, 072, Real Property; § 551. 073,

Prospective Gifts; § 551. 074, Personnel Matters; § 551. 075, Investments;

and §551. 076, Security Devices/ Audits.

ADJOURN TO REGULAR SESSION

VI.     TAKE ANY ACTION ON ANY ITEM DISCUSSED IN EXECUTIVE

SESSION AS NEEDED.

VII.     COURT DISCUSSION / PROPOSED AGENDA ITEMS

Commissioners may discuss items on the agenda or suggest items for future

agendas. Proposed agenda items may only be discussed by Commissioners
if the Commissioners do so to propose that those items be placed on a future
agenda). Items not appearing on the agenda may not be deliberated and no
votes may be taken during this portion of the agenda.  In response to

comments from the public, Council may seek a statement of specific factual

information or a recitation of existing policy from County Staff pursuant to
Section 551. 042 of the Texas Open Meetings Act).

ADJOURN

Rains County Judge Brent Hilliard





THE STATE OF TEXAS RAINS COUNTY

COMMISSIONERS

COUNTY OF RAINS COURT

July 24, 2025

Be it remembered, the Commissioners Court of Rains County, Texas, this Regular
Meeting being convened in the Rains County Courthouse, on Thursday, the 24th day of July
2025, at 10: 00 a.m. with the following members of the court being present:

COUNTY COMMISSIONER MIKE WILLIS

COUNTY COMMISSIONER JEREMY COOK
COUNTY COMMISSIONER LORI NORTHCUTT

COUNTY COMMISSIONER KOREY YOUNG

Recorded proceedings of court duly transcribed by:

MANDY SAWYER

COUNTY CLERK/ COURT EX- OFFICIO

The agenda was prepared by the Judge' s office announcing a meeting to be held by
the Commissioners on Thursday, the 24th day of July 2025, at 10: 00 a.m.

The posted meeting of the Commissioners Court was held on Thursday, the 24th day
of July 2025, at 10: 00 a.m.

I. CALL MEETING TO ORDER, PLEDGES OF ALLEGIANCE& INVOCATION

Meeting was called to order by Commissioner Mike Willis. Commissioner Korey
Young led the Court with the Pledge of Allegiance to the United States of America Flag and
the Pledge of Allegiance to the Texas Flag; Commissioner Mike Willis led the invocation.

II.       PUBLIC TESTIMONY

III.      PRESENTATIONS

IV.      OLD BUSINESS

A.  ACTION ITEMS

V.       NEW BUSINESS

A.  CONSENT CALENDAR

1.  Road and Bridge Reports

N/ A

2.  Permits and Right- of-way
3.  Environmental enforcement and Emergency Management
4.  Grant Development

5.  Courthouse Security
Moved by Commissioner Korey Young, duly

seconded by Commissioner Lori Northcutt to accept the Departmental Reports into the
meeting minutes.

11Page





6.  Approving minutes of prior regular or special meeting.
Moved by Commissioner Korey Young, duly seconded

by Commissioner Lori Northcutt to approve the Commissioner Court minutes of prior
regular or special meetings.

Court Members Voting Aye: Mike Willis, Jeremy Cook,
Lori Northcutt and Korey Young.

Court Members Voting No: None
Court Members Abstaining: None
Motion Carried

B.  ACTION ITEMS- Discuss and possibly take action on the following:
1.  Approval of account payable1

Moved by Commissioner Jeremy Cook, duly seconded
by Commissioner Korey Young to approve accounts payable in the amount of$ 222, 718. 58

Court Members Voting Aye: Mike Willis, Jeremy Cook,
Lori Northcutt and Korey Young.

Court Members Voting No: None
Court Members Abstaining: None
Motion Carried

2.  Approval of line- item transfers

N/ A

3.  Approval of budget amendments

N/ A

4.  Approval of payroll and personnel2
Moved by Commissioner Jeremy Cook, duly seconded

by Commissioner Korey Young to approve any and all payroll and personnel changes.
Court Members Voting Aye: Mike Willis, Jeremy Cook,

Lori Northcutt and Korey Young.
Court Members Voting No: None
Court Members Abstaining: None
Motion Carried

5.  Road and bridge request a transfer of$ 75,000 to cover the

culverts purchases, flex base and the 3" overlay of Type D cold mix to Upgrade. 73 of a mile
on CR 1325 and transfer the funds to the Road Material line 010- 1150- 52320.

Moved by Commissioner Jeremy Cook, duly seconded
by Commissioner Lori Northcutt to approve the request for a transfer of$ 75, 000 to cover
the culverts purchases, flex base and the 3' overlay of Type D cold mix to Upgrade. 73 of a
mile on CR 1325 and transfer the funds to the Road Material line 010- 1150- 52320.

Court Members Voting Aye: Mike Willis, Jeremy Cook,
Lori Northcutt and Korey Young.

Court Members Voting No: None
Court Members Abstaining: None
Motion Carried

6.  Onsite sewage Audit and Proposed organization of

1 Payables Report

2 Payroll/ Personnel Report

Wage





Department3

Moved by Commissioner Korey Young, duly seconded
by Commissioner Lori Northcutt to approve the Onsite Sewage Audit contract.

Court Members Voting Aye: Mike Willis, Jeremy
Cook, Lori Northcutt and Korey Young.

Court Members Voting No: None
Court Members Abstaining: None
Motion Carried

7.  Quote for cameras in the County Annex Courtroom.4
Moved by Commissioner Jeremy Cook, duly

seconded by Commissioner Korey Young to approve the purchase of cameras for the
Courthouse Annex in the amount of$ 2, 148. 93 paid from the courthouse security fund.

Court Members Voting Aye: Mike Willis, Jeremy
Cook, Lori Northcutt and Korey Young.

Court Members Voting No: None
Court Members Abstaining: None
Motion Carried

8.  Termination of copier maintenance contract between

Hilliard Office Solutions LTC and Rains County.
Moved by Commissioner Lori Northcutt, duly

seconded by Commissioner Korey Young to approve the termination of copier maintenance
between Hilliard Office Solutions LTC and Rains County.

Court Members Voting Aye: Mike Willis, Jeremy
Cook, Lori Northcutt and Korey Young.

Court Members Voting No: None
Court Members Abstaining: None
Motion Carried

9.  Courthouse repair bid.5

N/ A

10. Guardian System, a software system for the jail.6

Moved by Commissioner Korey Young, duly
seconded by Commissioner Lori Northcutt to approve the Guardian Software System for
the first year, in the amount of$ 4,218.00 paid out of commissary funds.

Court Members Voting Aye: Mike Willis, Jeremy
Cook, Lori Northcutt and Korey Young.

Court Members Voting No: None
Court Members Abstaining: None
Motion Carried

11. Consider purchase ofAutomated External Defibrillators
AED) for county buildings.?

3

Rains County OSSF Audit
4

3AM Holdings quote/ cameras in the courtroom annex
5

Project Cost Estimate
6

Guardian System Instructions

CardiacLife Quotes

Wage





N/ A

12. Consider action on adopting a Fraud, Waste, and Abuse
policy. 8

Moved by Commissioner Korey Young, duly
seconded by Commissioner Jeremy Cook to adopt the Fraud, Waste, and Abuse policy.

Court Members Voting Aye: Mike Willis, Jeremy Cook,
Lori Northcutt and Korey Young.

Court Members Voting No: None
Court Members Abstaining: None
Motion Carried

ADJOURN TO EXECUTIVE SESSION

VI.      EXECUTIVE SESSIONS
1.  As permitted by Texas Government Code§ 551. 071 ( 1) and ( 2), Consultation

with Attorney; § 551. 074, Personnel Matters; § 551. 075; Investments; and§ 551. 076,

Security Devices/ Audits.

ADJOURN TO REGULAR SESSION

VII.     TAKE ANY ACTION ON ANY ITEM DISCUSSED IN EXECUTIVE SESSION AS
NEEDED.

VIII.    COURT DISCUSSION/ PROPOSED AGENDA ITEMS

ADJOURN

Moved by Commissioner Lori Northcutt, duly seconded
by Commissioner Korey Young to adjourn.

Court Members Voting Aye: Mike Willis, Jeremy Cook,
Lori Northcutt and Korey Young.

Court Members Voting No: None
Court Members Abstaining: None
Motion Carried.

With no further business to be considered by the Court at 10: 40 a. m., Commissioner
Mike Willis declare o missioners o} rt adjourned.

On this the sa day of F 2025, I, Mandy Sawyer, attest to the
accuracy of this record.

GP.-
EFt

S,CO

U
Mandy Sa er

SEAL
9`  ............:.      

Nse Rains County Clerk
1111NNN

t

8

RC Fraud, Waste, and Abuse policy

4IPage





w  ` ` ` 1 Payables Report 07-24-2025
d Rains County, TX By Purchased From Vendor

Vendor Name Payable Number Post Date Description( Item)    Account Number Amount

Purchased From Vendor. 3AM HOLDINGS LLC

3AM HOLDINGS LLC 100001814 07/ 24/ 2025 SHRF IT Services 002- 1175- 57130 1, 207. 50
3AM HOLDINGS LLC 100001829 07/ 24/ 2025 IT Services 002- 1175- 57130 1, 811. 25
3AM HOLDINGS LLC 100001854 07/ 24/ 2025 Monthly Cyber Security 002- 1175- 57180 160. 00
3AM HOLDINGS LLC 100001867 07/ 24/ 2025 SHRF Monthly Cyber Security 002- 1175- 57180 80. 00
3AM HOLDINGS LLC 100001878 07/ 24/ 2025 IT-8 Port Switch Replacement 002- 1175- 58130 159. 99
3AM HOLDINGS LLC 100001879 07/ 24/ 2025 IT-4 Hard Drives for JP/ Judge' s 002- 1175- 58130 636. 00

Purchased From Vendor 3AM HOLDINGS U.0 Total: 4, 054. 74

Purchased From Vendor: AFLAC

AFLAC INV0001097 07/ 09/ 2025 PY AFLAC Accident( AfterTax)   002- 21320 5. 94
AFLAC INV0001098 07/ 09/ 2025 PY AFLAC Accident( Pre- Tax) D 002- 21320 182. 59
AFLAC INV0001098 07/ 09/ 2025 PY AFLAC Accident( Pre- Tax) D 010- 21320 39. 12
AFLAC INV0001099 07/ 09/ 2025 PY AFLAC Cancer( Pre- Tax) De 002- 21320 138. 44
AFLAC INV0001099 07/ 09/ 2025 PY AFLAC Cancer( Pre- Tax) De 010- 21320 18. 63
AFLAC INV0001100 07/ 09/ 2025 PY AFLAC Hospital( Pre-Tax) D 002- 21320 94. 80
AFLAC INV0001101 07/ 09/ 2025 PY AFLAC Life( After Tax) Dedu 002- 21320 31. 32
AFLAC INV0001102 07/ 09/ 2025 PY AFLAC Spec Event( Pre- Tax) 002- 21320 62. 04
AFLAC 670521 07/ 24/ 2025 COBRA Pmt 002- 21330 161. 82
AFLAC INV0001175 07/ 23/ 2025 PY AFLAC Accident( AfterTax)   002- 21320 5. 94
AFLAC INV0001176 07/ 23/ 2025 PY AFLAC Accident( Pre-Tax) D 002- 21320 182. 59
AFLAC 1NV0001176 07/ 23/ 2025 PY AFLAC Accident( Pre- Tax) D 010- 21320 39. 12
AFLAC INV0001177 07/ 23/ 2025 PY AFLAC Cancer( Pre- Tax) De 002- 21320 138. 44
AFLAC INV0001177 07/ 23/ 2025 PY AFLAC Cancer( Pre- Tax) De 010- 21320 18. 63
AFLAC INV0001178 07/ 23/ 2025 PY AFLAC Hospital( Pre- Tax) D 002- 21320 94. 80
AFLAC INV0001179 07/ 23/ 2025 PY AFLAC Ufe( After Tax) Dedu 002- 21320 31. 32
AFLAC INV0001180 07/ 23/ 2025 PY AFLAC Spec Event( Pre- Tax) 002- 21320 62. 04

Purchased From Vendor AFLAC Total: 1, 307. 58

Purchased From Vendor: ALLIED NATIONAL INSURANCE

ALLIED NATIONAL INSURANCE INV0001103 07/ 09/ 2025 PY Dependant Dental Employ 002- 21225 527. 59
ALLIED NATIONAL INSURANCE INV0001103 07/ 09/ 2025 PY Dependant Dental Employ 010- 21225 90. 93
ALLIED NATIONAL INSURANCE INV0001104 07/ 09/ 2025 PY Dental Employer Portion 002- 21225 2, 080. 00
ALLIED NATIONAL INSURANCE INV0001104 07/ 09/ 2025 PY Dental Employer Portion 010- 21225 352. 00
ALLIED NATIONAL INSURANCE 214776 8/ 25 07/ 24/ 2025 COBRA Pmts 002- 21330 325. 00
ALLIED NATIONAL INSURANCE 214776 Balance 07/ 24/ 2025 Balance for Dental Ins. 002- 21225 144. 96
ALLIED NATIONAL INSURANCE CM0000057 07/ 23/ 2025 PY Dental Employer Portion 002- 21225 64. 00
ALLIED NATIONAL INSURANCE INV0001181 07/ 23/ 2025 PY Dependant Dental Employ 002- 21225 527. 59
ALLIED NATIONAL INSURANCE INV0001181 07/ 23/ 2025 PY Dependant Dental Employ 010- 21225 90. 93

Purchased From Vendor ALLIED NATIONAL INSURANCE Total: 4,075. 00

Purchased From Vendor: ANDREWS CENTER

ANDREWS CENTER INV0001153 07/ 24/ 2025 Inmate Health 002- 1005- 55320 183. 00

Purchased From Vendor ANDREWS CENTER Total:  183. 00

Purchased From Vendor: ATMOS ENERGY

ATMOS ENERGY 3044145298 7/ 25 07/ 24/ 2025 SHRF/ Jail- Gas 002- 1109- 51210 241. 00
ATMOS ENERGY 3044145298 7/ 25 07/ 24/ 2025 SHRF/ Jail- Gas 002- 1110- 51210 241. 00
ATMOS ENERGY 3021238810 7/ 25 07/ 24/ 2025 Annex- Gas 002- 1002- 51210 8. 54
ATMOS ENERGY 3021238810 7/ 25 07/ 24/ 2025 Annex- Gas 002- 1003- 51210 8. 54
ATMOS ENERGY 3021238810 7/ 25 07/ 24/ 2025 Annex- Gas 002- 1006- 51210 8. 54
ATMOS ENERGY 3021238810 7/ 25 07/ 24/ 2025 Annex- Gas 002- 1007- 51210 8. 54
ATMOS ENERGY 3021238810 7/ 25 07/ 24/ 2025 Annex- Gas 002- 1030- 51210 12. 82
ATMOS ENERGY 3021238810 7/ 25 07/ 24/ 2025 Annex- Gas 002- 1060- 51210 12. 84
ATMOS ENERGY 3021238810 7/ 25 07/ 24/ 2025 Annex-Gas 002- 1065- 51210 12. 82
ATMOS ENERGY 3021238810 7/ 25 07/ 24/ 2025 Annex- Gas 002- 1075- 51210 8. 54
ATMOS ENERGY 3021238810 7/ 25 07/ 24/ 2025 Annex- Gas 002- 1080- 51210 4. 27

e.
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Payables Report 07- 24- 2025

Vendor Name Payable Number Post Date Description( Item)    Account Number Amount

ATMOS ENERGY 3021239006 7/ 25 07/ 24/ 2025 Arr Bldg- Gas 002- 1085-51210 11. 11

ATMOS ENERGY 3021239006 7/ 25 07/ 24/ 2025 Arr Bldg- Gas 002- 1114- 51210 10. 62

ATMOS ENERGY 3021239006 7/ 25 07/ 24/ 2025 Arr Bldg- Gas 002- 1115- 51210 10. 62

ATMOS ENERGY 3021239006 7/ 25 07/ 24/ 2025 Arr Bldg- Gas 002- 1116- 51210 10. 62

ATMOS ENERGY 3021239006 7/ 25 07/ 24/ 2025 Arr Bldg- Gas 002- 1121- 51210 10. 62

ATMOS ENERGY 3021239006 7/ 25 07/ 24/ 2025 Arr Bldg- Gas 002- 1122- 51210 10. 62

ATMOS ENERGY 3021239006 7/ 25 07/ 24/ 2025 Arr Bldg- Gas 002- 1123- 51210 10. 62

ATMOS ENERGY 3021239006 7/ 25 07/ 24/ 2025 Arr Bldg- Gas 002- 1124-51210 10. 62

ATMOS ENERGY 3024945578 7/ 25 07/ 24/ 2025 Clark Bldg- Gas 002- 1006- 51210 42. 73

ATMOS ENERGY 3024945578 7/ 25 07/ 24/ 2025 Clark Bldg- Gas 002- 1040- 51210 21. 36

ATMOS ENERGY 3024945578 7/ 25 07/ 24/ 2025 Clark Bldg- Gas 002- 1120- 51210 21. 36

ATMOS ENERGY 3044128717 7/ 25 07/ 24/ 2025 Old DL Office- Gas 002- 1006- 51210 86. 53

ATMOS ENERGY 40370991917/ 25 07/ 24/ 2025 Library- Gas 034- 1125- 51210 92. 50

Purchased From Vendor ATMOS ENERGY Total: 917. 38

Purchased From Vendor: CHRIS MARTIN

CHRIS MARTIN Travel Reimb 6/ 25 07/ 24/ 2025 8thDist- Visiting Judge from Va 002- 1002- 54120 32. 16

Purchased From Vendor CHRIS MARTIN Total:  32. 16

Purchased From Vendor: CHRISTUS HOPKINS COUNTY HEALTH HOSPITAL

CHRISTUS HOPKINS COUNTY INV0001154 07/ 24/ 2025 Inmate Heath Care 002- 1005- 55320 41. 08

Purchased From Vendor CHRISTUS HOPKINS COUNTY HEALTH HOSPITAL Total:  41. 08

Purchased From Vendor: CHRISTUS TRINITY CLINIC

CHRISTUS TRINITY CLINIC INV0001155 07/ 24/ 2025 Indigent Heath Care Office Vis 002- 1005- 56200 47. 68

Purchased From Vendor CHRISTUS TRINITY CLINIC Total:  47. 68

Purchased From Vendor: CITY OF EMORY

CITY OF EMORY Acct 108 7/ 25 07/ 24/ 2025 CLARK BLDG WATER 002- 1006- 51220 32. 27

CITY OF EMORY Acct 108 7/ 25 07/ 24/ 2025 CLARK BLDG WATER 002- 1040- 51220 16. 13

CITY OF EMORY Acct 108 7/ 25 07/ 24/ 2025 CLARK BLDG WATER 002- 1120- 51220 16. 13

CITY OF EMORY Acct 1117/ 25 07/ 24/ 2025 SHRF/ JAIL WATER 002- 1109- 51220 297. 07

CITY OF EMORY Acct 1117/ 25 07/ 24/ 2025 SHRF/ JAIL WATER 002- 1110- 51220 297. 06

CITY OF EMORY Acct 7617/ 25 07/ 24/ 2025 AGRILIFE WATER 002- 1010- 51220 124. 39

CITY OF EMORY Acct 764 7/ 25 07/ 24/ 2025 ARR BLDG WATER 002- 1085- 51220 9. 64

CITY OF EMORY Acct 764 7/ 25 07/ 24/ 2025 ARR BLDG WATER 002- 1114- 51220 7. 25

CITY OF EMORY Acct 764 7/ 25 07/ 24/ 2025 ARR BLDG WATER 002- 1115- 51220 7. 25

CITY OF EMORY Acct 764 7/ 25 07/ 24/ 2025 ARR BLDG WATER 002- 1116- 51220 7. 25

CITY OF EMORY Acct 764 7/ 25 07/ 24/ 2025 ARR BLDG WATER 002- 1121- 51220 7. 25

CITY OF EMORY Acct 764 7/ 25 07/ 24/ 2025 ARR BLDG WATER 002- 1122- 51220 7. 25

CITY OF EMORY Acct 764 7/ 25 07/ 24/ 2025 ARR BLDG WATER 002- 1123- 51220 7. 25

CITY OF EMORY Acct 764 7/ 25 07/ 24/ 2025 ARR BLDG WATER 002- 1124- 51220 7. 25

CITY OF EMORY Acct 295 7/ 25 07/ 24/ 2025 UBRARY WATER 034- 1125- 51220 169. 10

CITY OF EMORY Acct 6117/ 25 07/ 24/ 2025 CRTHSE WATER 002- 1006- 51220 433. 10

CITY OF EMORY Acct 6117/ 25 07/ 24/ 2025 CRTHSE WATER 002- 1070- 51220 133. 27

CITY OF EMORY Acct 6117/ 25 07/ 24/ 2025 CRTHSE WATER 002- 1090- 51220 133. 27

CITY OF EMORY Acct 6117/ 25 07/ 24/ 2025 CRTHSE WATER 002- 1100- 51220 133. 27

CITY OF EMORY Acct 836 7/ 25 07/ 24/ 2025 ANNEX WATER 002- 1002- 51220 42. 98

CITY OF EMORY Acct 836 7/ 25 07/ 24/ 2025 ANNEX WATER 002- 1003- 51220 42. 98

CITY OF EMORY Acct 836 7/ 25 07/ 24/ 2025 ANNEX WATER 002- 1006- 51220 42. 98

CITY OF EMORY Acct 836 7/ 25 07/ 24/ 2025 ANNEX WATER 002- 1007-51220 42. 98

CITY OF EMORY Acct 836 7/ 25 07/ 24/ 2025 ANNEX WATER 002- 1030- 51220 64.47

CITY OF EMORY Acct 836 7/ 25 07/ 24/ 2025 ANNEX WATER 002- 1060- 51220 64. 47

CITY OF EMORY Acct 836 7/ 25 07/ 24/ 2025 ANNEX WATER 002- 1065- 51220 64. 47

CITY OF EMORY Acct 836 7/ 25 07/ 24/ 2025 ANNEX WATER 002- 1075-51220 42.98

CITY OF EMORY Acct B36 7/ 25 07/ 24/ 2025 ANNEX WATER 002-1080-51220 21. 49

CITY OF EMORY Acct 7817/ 25 07/ 24/ 2025 CHILD ADVOCACY WATER 002- 1006- 51220 113. 00

Purchased From Vendor CITY OF EMORY Total: 2, 388. 25

Purchased From Vendor: CLAY JOHNSON LAW P. C.

CLAY JOHNSON LAW P. C.      Caber# 6739 07/ 24/ 2025 8thOist- Court Appt Atty 002- 1002- 54100 300. 00

CLAY JOHNSON LAW P. C.      Finke# 6642 07/ 24/ 2025 8thDist- Court Appt Atty 002- 1002- 54100 400.00



Payables Report 07-24- 202S

Vendor Name Payable Number Post Date Description( Item)    Account Number Amount
CLAY JOHNSON LAW P. C.      Platter# 6735/ 3736/ 6737/ 673 07/ 24/ 2025 8thDist- Court Appt Atty 002- 1002- 54100 550. 00

Purchased From Vendor CLAY JOHNSON LAW P.C. Total: 1, 250.00
Purchased From Vendor: CNA SURETY

CNA SURETY Bond# 67550833 07/ 24/ 2025 Judge- Bond 002- 1070- 51330 647. 50CNA SURETY 65649432 07/ 24/ 2025 CCLERK- 8ond 002- 1060- 51330 140. 00CNA SURETY Bond# 65649459 07/ 24/ 2025 BOND FOR ELECTIONS ADMIN 002- 1007- 51330 129. 50CNA SURETY Bond# 67561009 07/ 24/ 2025 JP- Bond Barnett 002- 1090- 51330 92. 50

Purchased From Vendor CNA SURETY Total: 1, 009. 50

Purchased From Vendor: CROSSROAD COMMUNICATIONS INC.
CROSSROAD COMMUNICATIO 15542 07/ 24/ 2025 R& B- TOWER LEASE 010- 1150- 51415 3Q0, 00

Purchased From Vendor CROSSROAD COMMUNICATIONS INC. Total: 300. 00

Purchased From Vendor: DANA DURHAM

DANA DURHAM Reimbursement 7/ 25 07/ 24/ 2025 Reimb Deductions for final pa 002- 21225 82. 54

Purchased From Vendor DANA DURHAM Total:  82. 54

Purchased From Vendor: DAVID HARVEY

DAVID HARVEY Travel Reimb 7/ 25 07/ 24/ 2025 VA- Travel Reimb 002- 1114- 51300 295. 20

Purchased From Vendor DAVID HARVEY Total: 295. 20

Purchased From Vendor: DAVID' S TIRE SHOP

DAVID' S TIRE SHOP 5387682 07/ 24/ 2025 R& B- 206 FIAT FIX 010- 1150- 52220 65. 00
DAVID' S TIRE SHOP 5387684 07/ 24/ 2025 R& B- 101- 111 4- DRIVE TIRES 010- 1150- 52225 225. 00
DAVID' S TIRE SHOP 5387686 07/ 24/ 2025 R& B- 400 2 TIRE DISPOSAL 010- 1150- 52220 45.00
DAVID' S TIRE SHOP 0610151 07/ 24/ 2025 R& B- 400 2 TIRE MOUNTS AN 010- 1150- 52220 375. 00

Purchased From Vendor DAVID' S TIRE SHOP Total: 710. 00

Purchased From Vendor: DEARBORN UFE INSURANCE COMPANY
DEARBORN LIFE INSURANCE C INV0001105 07/ 09/ 2025 PY DN Life& AD& D Employer 002- 21225 342. 69
DEARBORN LIFE INSURANCE C INV0001105 07/ 09/ 2025 PY DN Life& AD& D Employer 010- 21225 63. 42
DEARBORN LIFE INSURANCE C INV0001111 07/ 09/ 2025 PY Long Term Disability Deduc 002- 21225 29. 60
DEARBORN LIFE INSURANCE C INV0001111 07/ 09/ 2025 PY Long Term Disability Deduc 010- 21225 65. 50
DEARBORN LIFE INSURANCE C INV0001112 07/ 09/ 2025 PY Short Term Disability Dedu 002- 21225 249.98
DEARBORN LIFE INSURANCE C INV0001112 07/ 09/ 2025 PY Short Term Disability Dedu 010- 21225 46. 51
DEARBORN LIFE INSURANCE C INV0001113 07/ 09/ 2025 PY Supp Life& AD& D- Child D 002- 21225 13. 97
DEARBORN LIFE INSURANCE C INV0001113 07/ 09/ 2025 PY Supp Life& AD& D- Child D 010- 21225 2. 54
DEARBORN LIFE INSURANCE C INV0001114 07/ 09/ 2025 PY Supp Life& AD& D Employ 002- 21225 325.84
DEARBORN LIFE INSURANCE C INV0001114 07/ 09/ 2025 PY Supp Life& AD& D Employ 010- 21225 98. 34
DEARBORN LIFE INSURANCE C INV0001115 07/ 09/ 2025 PY Supp Life& AD& D- Spouse 002- 21225 52. 57
DEARBORN LIFE INSURANCE C INV0001115 07/ 09/ 2025 PY Supp Life& AD& D- Spouse 010- 21225 18. 46
DEARBORN LIFE INSURANCE C CM0000058 07/ 23/ 2025 PY DN Life& AD& D Employer 002- 21225 9. 95
DEARBORN LIFE INSURANCE C INV0001185 07/ 23/ 2025 PY Long Term Disability Deduc 002- 21225 29. 60
DEARBORN LIFE INSURANCE C INV0001185 07/ 23/ 2025 PY Long Term Disability Deduc 010- 21225 65. 50
DEARBORN LIFE INSURANCE C INV0001186 07/ 23/ 2025 PY Short Term Disability Dedu 002- 21225 215. 14
DEARBORN UFE INSURANCE C INV0001186 07/ 23/ 2025 PY Short Term Disability Dedu 010- 21225 46. 51
DEARBORN LIFE INSURANCE C INV0001187 07/ 23/ 2025 PY Supp Life& AD& D- Child D 002- 21225 13. 97
DEARBORN LIFE INSURANCE C INV0001187 07/ 23/ 2025 PY Supp Life& AD& D- Child D 010- 21225 2. 54
DEARBORN LIFE INSURANCE C INV0001188 07/ 23/ 2025 PY Supp Life& AD& D Employ 002- 21225 271. 30
DEARBORN LIFE INSURANCE C INV0001188 07/ 23/ 2025 PY Supp Life& AD& D Employ 010- 21225 98. 34
DEARBORN LIFE INSURANCE C INV0001189 07/ 23/ 2025 PY Supp Life& AD& D- Spouse 002- 21225 52. 57
DEARBORN LIFE INSURANCE C INV0001189 07/ 23/ 2025 PY Supp Life& AD& D- Spouse 010- 21225 18. 46

Purchased From Vendor DEARBORN LIFE INSURANCE COMPANY Total: 2, 113. 40

Purchased From Vendor: DIGITAL GRAPHICS LLC

DIGITAL GRAPHICS LLC 11760 07/ 24/ 2025 EmgMgmt- Dumpster Labels 002- 1115- 58130 120. 00
DIGITAL GRAPHICS LLC 11764 07/ 24/ 2025 R& B- 2 COURT SHIRTS 010- 1150- 51315 83. 96
DIGITAL GRAPHICS LLC 11780 07/ 24/ 2025 R& B- RONNIE COURT SHIRTS 010- 1150- 51315 83. 96

Purchased From Vendor DIGITAL GRAPHICS LLC Total: 287. 92

Purchased From Vendor: DUKO OIL CO

DUKO OIL CO D50625 07/ 24/ 2025 R& B- 110 DD 13GAL D50625 010- 1150- 52200 31. 92
DUKO OIL CO D50626 07/ 24/ 2025 R& B- 111 FUEL 55. 30GAL D50 010- 1150- 52200 146. 49
DUKO OIL CO D50632 07/ 24/ 2025 R& B- 120 FUEL 12. 810GAL 05 010- 1150- 52200 33. 91
DUKO OIL CO D50633 07/ 24/ 2025 R& B- 121 FUEL 31GAL D5063 010- 1150- 52200 82. 12



Payables Report 07. 24- 2025

Vendor Name Payable Number Post Date Description( Item)    Account Number Amount

DUKO OIL CO D50635 07/ 24/ 2025 R& B- 101 FUEL 50. 90GAL D50 010- 1150- 52200 134. 84

DUKO OIL CO 050636 07/ 24/ 2025 R& B- 111 FUEL 45GAL D5063 010- 1150- 52200 119. 21

DUKO OIL CO D50643 07/ 24/ 2025 R& B- 101 FUEL 48. 10GAL D50 010- 1150- 52200 133. 66

DUKO OIL CO D50644 07/ 24/ 2025 R& B- 111 FUEL 42. 90GAL D50 010- 1150- 52200 119. 21

DUKO OIL CO D50645 07/ 24/ 2025 R& B- 120 FUEL 18. SOGAL D50 010- 1150- 52200 51. 41

DUKO OIL CO D50646 07/ 24/ 2025 R& B- 110 DD 50GAL D50646 010- 1150- 52200 126. 04

DUKO OIL CO D50649 07/ 24/ 2025 R& B- 101 FUEL 36.90GAL DSO 010- 1150- 52200 100. 21

DUKO OIL CO D50650 07/ 24/ 2025 R& B- 111 FUEL 39 GAL D5065 010- 1150- 52200 105. 91

DUKO OIL CO D50653 07/ 24/ 2025 R& 8- 110 DD 36GAL 050653 010- 1150- 52200 88. 40

DUKO OIL CO D50654 07/ 24/ 2025 R& B- 129 DO 70GAL 050654 010- 1150- 52200 171. 88

DUKO OIL CO D50657 07/ 24/ 2025 R& B- 111 FUEL 41GAL D5065 010- 1150- 52200 108. 61

DUKO OIL CO D50658 07/ 24/ 2025 R& B- 101 FUEL 37. 20GAL D50 010- 1150- 52200 98. 54

DUKO OIL CO D50659 07/ 24/ 2025 R& B- 110 DD 54GAL D50659 010- 1150-52200 132. 59

DUKO OIL CO D50660 07/ 24/ 2025 R& B- 110 FUEL 22. 4 DD 21. 20 010- 1150- 52200 111. 40

DUKO OIL CO D50661 07/ 24/ 2025 R& B- 111 FUEL 39GAL D5066 010- 1150- 52200 103. 31

DUKO OIL CO D50662 07/ 24/ 2025 R& B- 101 FUEL 37. 3 050662 010- 1150- 52200 98. 81

Purchased From Vendor DUKO OIL CO Total: 2, 098. 47

Purchased From Vendor: EMORY DENTAL

EMORY DENTAL INV0001156 07/ 24/ 2025 Inmate Tooth Extractions 002- 1005- 55320 380. 00

Purchased From Vendor EMORY DENTAL Total: 380.00

Purchased From Vendor: HOOTEN' S WESTSIDE STORAGE

HOOTEN' S WESTSIDE STORAG Unit# 02083 07/ 24/ 2025 CCLERK- YEARLY STORAGE OF 014- 1060- 51420 1, 265. 00

Purchased From Vendor HOOTEN' S WESTSIDE STORAGE Total: 1, 265. 00

Purchased From Vendor: HOOTEN' S LLC

HOOTEN' S LLC 2507-042019 07/ 24/ 2025 R& B- 1325 6- 12X20 2- 12X30 3 010- 1150- 52351 3, 865. 10

HOOTEN' S LLC 2507- 044662 07/ 24/ 2025 Maint- 2x4' s, 2x6' s 002- 1006- 52100 232. 95

HOOTEN' S LLC 2507-045334 07/ 24/ 2025 R& B- 1325 PORTLAND CEMEN 010- 1150- 52320 41. 98

HOOTEN' S LLC 2507- 045744 07/ 24/ 2025 Maint- ZipTape, MskgTape, Oil,  002- 1006- 52100 73. 85

HOOTEN' S LLC 2507- 047033 07/ 24/ 2025 Maint- Toilet Bowl Cleaner 002- 1006- 51135 6. 98

HOOTEN' S LLC 2507- 048736 07/ 24/ 2025 Maint- Markers, Bit, Naiis, Bolts 002- 1006- 52100 107. 13

HOOTEN' S LLC 2507- 048757 07/ 24/ 2025 Maint- Hand Soap, 5 Pk Bits 002- 1006- 51135 7. 98

HOOTEN' S LLC 2507- 048757 07/ 24/ 2025 Spk Bit Insert 002- 1006- 58130 10. 99

HOOTEN' S LLC 2507- 048844 07/ 24/ 2025 Maint- Disposable Respirator 002- 1006- 51135 17. 99

HOOTEN' S LLC 2507- 049457 07/ 24/ 2025 Maint- Fan, Deadbolts 002- 1006- 52100 37. 98

HOOTEN' S LLC 2507- 049457 07/ 24/ 2025 Maint- Fan, Deadbolts 002- 1006- 58130 37. 99

HOOTEN' S LLC 2507- 049520 07/ 24/ 2025 Maint- Paint Roller Covers 002- 1006- 52100 22. 74

HOOTEN' S LLC 2507- 051561 07/ 24/ 2025 Maint- Febreze 002- 1006- 51135 9. 98

Purchased From Vendor HOOTEN' S LLC Total: 4,473. 64

Purchased From Vendor: HUNT REGIONAL MEDICAL PARTNERS# 33

HUNT REGIONAL MEDICAL PA INV0001157 07/ 24/ 2025 Inmate Health care 002- 1005- 55320 2, 417. 92

Purchased From Vendor HUNT REGIONAL MEDICAL PARTNERS# 33 Total: 2, 417. 92

Purchased From Vendor: INTEGRATED PRESCRIPTION MANAGEMENT CORP

INTEGRATED PRESCRIPTION INV0001158 07/ 24/ 2025 Intdlgent Health Care Prescrip 002- 1005- 56200 98. 65

Purchased From Vendor INTEGRATED PRESCRIPTION MANAGEMENT CORP Total:  98. 65

Purchased From Vendor: J& R DISCOUNT AUTO SUPPLY

1& R DISCOUNT AUTO SUPPLY 01NV036107 07/ 24/ 2025 R& B- 120 TURBO HOSE 010- 1150- 52225 11. 31

1& R DISCOUNT AUTO SUPPLY 01NV036438 07/ 24/ 2025 R& B- 508 ATF 010- 1150- 52220 39. 72

Purchased From Vendor J& R DISCOUNT AUTO SUPPLY Total:  51. 03

Purchased From Vendor: LAW OFFICE OF RACHEL FLAT!'

LAW OFFICE OF RACHEL FLAT Rogers# 6720 07/ 24/ 2025 8thDist- Court Appt Atty 002- 1002- 54100 350. 00

LAW OFFICE OF RACHEL FLAT Willis# 6677 07/ 24/ 2025 8thDlst-Court Appt Atty 002- 1002- 54100 800.00

Purchased From Vendor LAW OFFICE OF RACHEL FLATT Total: 1, 150. 00

Purchased From Vendor: USA KNEIFL

LISA KNEIFL Advance Travel Allow 8/ 10/ 25 07/ 24/ 2025 Elect- Advance Travel Allow 8/  002- 1007- 51300 478. 40

Purchased From Vendor USA KNEIFL Total: 478. 40



Payabies Report 07- 24- 2025

Vendor Name Payable Number Post Date Description( Item)    Account Number Amount
Purchased From Vendor: LONGVIEW ASPHALT INC.
LONGVIEW ASPHALT INC.      181734 07/ 24/ 2025

R& B- YARD1 0S17. 45TN 1817 010- 1150- 52320 1, 657. 75
Purchased From Vendor LONGVIEW ASPHALT INC. Total: 1, 657.75

Purchased From Vendor: LORD ABBETT 457 PLAN
LORD ABBETT 457 PLAN INV0001093 07/ 09/ 2025 PY Deferred Comp 457( b) Afte 002- 21226LORD ABBETT 457 PLAN INV0001094 07/ 09/ 2025 PY Deferred Comp 457( b) Afte 002- 21226

65. 00

54. 84LORD ABBETT 457 PLAN INV0001095 07/ 09/ 2025 PY Deferred Comp 457( b) Pre- 002- 21226 100,00LORD ABBETT 457 PLAN INV0001096 07/ 09/ 2025 PY Deferred Comp 457( b) Pre-  002- 21226
LORD ABBETT 457 PLAN INV0001171 90. 64

07/ 23/ 2025 PY Deferred Comp 457( b) Afte 002- 21226 65. 00LORD ABBETT 457 PLAN INV0001172 07/ 23/ 2025 PY Deferred Comp 457( b) Afte 002- 21226 55. 18LORD ABBETT 457 PLAN INV0001173 07/ 23/ 2025 PY Deferred Comp 457( b) Pre- 002- 21226 100. 00LORD ABBETT 457 PLAN INV0001174 07/ 23/ 2025 PY Deferred Comp 457( b) Pre-  002- 21226 90. 64
Purchased From Vendor LORD ABBETT 457 PLAN Total: 621. 30

Purchased From Vendor. NORTHSTAR ANESTHESIA PA
NORTHSTAR ANESTHESIA PA INV0001159 07/ 24/ 2025 Indigent Health Anestesia 002- 1005- 56200 122. 35

Purchased From Vendor NORTHSTAR ANESTHESIA PA Total: 122. 35
Purchased From Vendor: NTTA

NTTA 2017709775 6/ 25 07/ 24/ 2025 VA-Tolls 002- 1114- 52225 108. 36

Purchased From Vendor NTTA Total: 108. 36
Purchased From Vendor: O' REILLY AUTO PARTS
O' REILLY AUTO PARTS 5658- 147041 07/ 24/ 2025 R& B- 108 JB WELD 010- 1150- 52225 13. 99O' REILLY AUTO PARTS 5658- 147476 07/ 24/ 2025 R& B- 108 JB WELD AND GLOV 010- 1150- 52225 17. 29

Purchased From Vendor O' REILLY AUTO PARTS Total:  31. 28
Purchased From Vendor: R. K. HALL LLC
R. K. HALL LLC 461413 07/ 24/ 2025 R& B- CTIF CHIP ROCK 010- 1150- 52320 25, 043. 38R. K. HALL LLC 463864 07/ 24/ 2025 R& B- 1325 TYPED 142. OSTN 4 010- 1150- 52320 11, 790. 15R. K. HALL LLC 463973 07/ 24/ 2025 R& B- 1325 TYPE D 142. 02TN 4 010- 1150- 52320 11, 787. 66R. K. HALL LLC 464021 07/ 24/ 2025 R& B- 1325 TYPE D 142. 02TN 4 010- 1150- 52320 11, 817. 54

Purchased From Vendor R. K. HALL LLC Total:      60,438.73
Purchased From Vendor: RELX INC.

RELX INC.    3095842904 07/ 24/ 2025 CAtty- Lexis Nexis Computer S 002- 1030- 51180 103. 00

Purchased From Vendor RELX INC. Total: 103.00
Purchased From Vendor: SECURE SHREDDING& RECYCLING
SECURE SHREDDING& RECYC 336762 07/ 24/ 2025 Env. Shredding Service 002- 1115- 51155 75. 00

Purchased From Vendor SECURE SHREDDING& RECYCLING Total:  75. 00
Purchased From Vendor: SHAWNA SHAHAN

SHAWNA SHAHAN 7771 07/ 24/ 2025 8thDist- Court Reporter Servic 002- 1002- 54120 513. 00
Purchased From Vendor SHAWNA SHAHAN Total: 513. 00

Purchased From Vendor:SHELL ENERGY SOLUTIONS
SHELL ENERGY SOLUTIONS 2175297- 53487097 07/ 24/ 2025 Library- Flood Light 034- 1125- 51200 15. 78SHELL ENERGY SOLUTIONS 2175297- 53489513 07/ 24/ 2025 Library- Electricity 034- 1125- 51200 472. 17SHELL ENERGY SOLUTIONS 2175297- 53489524 07/ 24/ 2025 Child Adv- Electricity 002- 1006- 51200 157. 99SHELL ENERGY SOLUTIONS 2175297- 53494801 07/ 24/ 2025 RB- Shop Electricity 010- 1150- 51200 283. 68SHELL ENERGY SOLUTIONS 2175297- 53507365 07/ 24/ 2025 Old DL Office- Electricity 002- 1006- 51200 228. 78SHELL ENERGY SOLUTIONS 2175297- 53507366 07/ 24/ 2025 Jail- Electricity 002- 1109- 51200 1, 588.99SHELL ENERGY SOLUTIONS 2175297- 53507368 07/ 24/ 2025 Arr. Bldg Electricity 002- 1085- 51200 36. 56SHELL ENERGY SOLUTIONS 2175297- 53507368 07/ 24/ 2025 Arr. Bldg Electricity 002- 1114- 51200 35. 00SHELL ENERGY SOLUTIONS 2175297- 53507368 07/ 24/ 2025 Arr. Bldg Electricity 002- 1115- 51200 35. 00SHELL ENERGY SOLUTIONS 2175297- 53507368 07/ 24/ 2025 Arr. Bldg Electricity 002- 1116- 51200 35. 00SHELL ENERGY SOLUTIONS 2175297- 53507368 07/ 24/ 2025 Arr. Bldg Electricity 002- 1121- 51200 35.00SHELL ENERGY SOLUTIONS 2175297- 53507368 07/ 24/ 2025 Arr. Bldg Electricity 002- 1122- 51200 35. 00SHELL ENERGY SOLUTIONS 2175297- 53507368 07/ 24/ 2025 Arr. Bldg Electricity 002- 1123- 51200 35. 00SHELL ENERGY SOLUTIONS 2175297- 53507368 07/ 24/ 2025 Arr. Bldg Electricity 002- 1124- 51200 35. 00

SHELL ENERGY SOLUTIONS 2175297- 53507370 07/ 24/ 2025 Multi Dept- Electricity 002- 1002- 51200 152. 02
SHELL ENERGY SOLUTIONS 2175297- 53507370 07/ 24/ 2025 Multi Dept- Electricity 002- 1003- 51200 152. 02
SHELL ENERGY SOLUTIONS 2175297- 53507370 07/ 24/ 2025 Multi Dept- Electricity 002- 1006- 51200 152. 02
SHELL ENERGY SOLUTIONS 2175297- 53507370 07/ 24/ 2025 Multi Dept- Electricity 002- 1007- 51200 152. 02
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SHELL ENERGY SOLUTIONS 2175297-53507370 07/ 24/ 2025 Multi Dept- Electricity 002- 1030- 51200 228. 00

SHELL ENERGY SOLUTIONS 2175297- 53507370 07/ 24/ 2025 Multi Dept- Electricity 002- 1060- 51200 228. 02

SHELL ENERGY SOLUTIONS 2175297- 53507370 07/ 24/ 2025 Multi Dept- Electricity 002- 1065- 51200 228. 02

SHELL ENERGY SOLUTIONS 2175297- 53507370 07/ 24/ 2025 Multi Dept- Electricity 002- 1075- 51200 152. 02

SHELL ENERGY SOLUTIONS 2175297- 53507370 07/ 24/ 2025 Multi Dept- Electricity 002- 1080- 51200 76. 01

SHELL ENERGY SOLUTIONS 2175297- 53507377 07/ 24/ 2025 SHRF- Electricity 002- 1110- 51200 1, 240. 86

SHELL ENERGY SOLUTIONS 2175297- 53508704 07/ 24/ 2025 SHRF/ Jail- Flood Light 002- 1109- 51200 19. 01

SHELL ENERGY SOLUTIONS 2175297- 53508704 07/ 24/ 2025 SHRF/ Jail- Flood Light 002- 1110- 51200 19. 00

SHELL ENERGY SOLUTIONS 2175297- 53509925 07/ 24/ 2025 Clark Bldg- Electricity 002- 1006- 51200 93. 54

SHELL ENERGY SOLUTIONS 2175297- 53509925 07/ 24/ 2025 Clark Bldg- Electricity 002- 1040- 51200 46. 77

SHELL ENERGY SOLUTIONS 2175297- 53509925 07/ 24/ 2025 Clark Bldg- Electricity 002- 1120- 51200 46. 77

SHELL ENERGY SOLUTIONS 2175297- 53511235 07/ 24/ 2025 Hill Bldg- Electricity 002- 1006- 51200 203. 21

SHELL ENERGY SOLUTIONS 2175297- 53511852 07/ 24/ 2025 R8- Point Yard Electricity 010- 1150- 51200 44. 86

Purchased From Vendor SHELL ENERGY SOLUTIONS Total: 6,263. 12

Purchased From Vendor: SOUTHERN TIRE MART LLC.

SOUTHERN TIRE MART LLC.    4170125049 07/ 24/ 2025 R& 8- 111 TIRES 010- 1150- 52210 1, 878. 20

SOUTHERN TIRE MART LLC.    4170125367 07/ 24/ 2025 R& 8- 400 BACK TIRES 010- 1150- 52210 1, 487. 94

Purchased From Vendor SOUTHERN TIRE MART LLC. Total: 3, 366. 14

Purchased From Vendor. TCDRS

TCDRS INV0001116 07/ 09/ 2025 PY TCDRS- Retirement Emplo 002- 21209 20, 762. 66

TCDRS INV0001116 07/ 09/ 2025 PY TCDRS- Retirement Empio 010- 21209 3, 361. 24

TCDRS INV0001116 07/ 09/ 2025 PY TCDRS- Retirement Emplo 034- 21209 519. 35

TCDRS INV0001190 07/ 23/ 2025 PY TCDRS- Retirement Emplo 002- 21209 21, 683. 16

TCDRS INV0001190 07/ 23/ 2025 PY TCDRS- Retirement Emplo 010- 21209 3, 641. 88

TCDRS INV0001190 07/ 23/ 2025 PY TCDRS- Retirement Emplo 034- 21209 538. 73

Purchased From Vendor TCDRS Total:       50,507. 02

Purchased From Vendor: TEXAS DEPARTMENT OF STATE HEALTH SERVICES

TEXAS DEPARTMENT OF STAT 2025763 07/ 24/ 2025 CClerk- Remote Birth Certlficat 002- 22140 58. 56

Purchased From Vendor TEXAS DEPARTMENT OF STATE HEALTH SERVICES Total:  58. 56

Purchased From Vendor: TEXAS STAR EQUIPMENT SALES/ RENTAL LLC

TEXAS STAR EQUIPMENT SALE 6321 07/ 24/ 2025 R& 8- 1325 STEEL WHEEL REN 010- 1150- 51415 3, 630.00

Purchased From Vendor TEXAS STAR EQUIPMENT SALES/ RENTAL LLC Total: 3, 630. 00

Purchased From Vendor. THOMSON REUTERS- WEST

THOMSON REUTERS- WEST 852171804 07/ 24/ 2025 CAtty- Software Subscription 002- 1030- 51180 90. 32

Purchased From Vendor THOMSON REUTERS- WEST Total:  90. 32

Purchased From Vendor: TWELFTH COURT OF APPEALS

TWELFTH COURT OF APPEALS April 2025 07/ 24/ 2025 Treas- April Appellate Fee 002- 22430 5. 00

TWELFTH COURT OF APPEALS May 2025 07/ 24/ 2025 Treas- May Appellate Fee 002- 22430 100. 00

TWELFTH COURT OF APPEALS June 2025 07/ 24/ 2025 Treas-June Appellate Fee 002- 22430 75. 00

Purchased From Vendor TWELFTH COURT OF APPEALS Total: 180. 00

Purchased From Vendor VERIZON WIRELESS

VERIZON WIRELESS 6118218404 07/ 24/ 2025 VA- Cell Phone 002- 1114- 57210 46. 26

Purchased From Vendor VERIZON WIRELESS Total:  46. 26

Purchased From Vendor: VISION SERVICE PLAN

VISION SERVICE PLAN INV0001118 07/ 09/ 2025 PY Vision Insurance- Employe 002- 21225 45. 00

VISION SERVICE PLAN INV0001118 07/ 09/ 2025 PY Vision Insurance- Employe 010- 21225 7. 36

VISION SERVICE PLAN INV0001119 07/ 09/ 2025 PY Vision Insurance- Employe 002- 21225 359. 34

VISION SERVICE PLAN INV0001119 07/ 09/ 2025 PY Vision Insurance- Employe 010- 21225 61. 76

VISION SERVICE PLAN 823274374 07/ 24/ 2025 RCAD Vision Pmt Aug 2025 002- 21225 46. 48

VISION SERVICE PLAN CM0000061 07/ 23/ 2025 PY Vision Insurance- Employe 002- 21225 11. 24

VISION SERVICE PLAN INV0001192 07/ 23/ 2025 PY Vision Insurance- Employe 002- 21225 45. 00

VISION SERVICE PLAN INV0001192 07/ 23/ 2025 PY Vision Insurance- Employe 010- 21225 7. 36

Purchased From Vendor VISION SERVICE PLAN Total: S61.06

Purchased From Vendor: WELLS FARGO

WELLS FARGO 5035071327 07/ 24/ 2025 MultOept-Copier Lease 002- 1010-51110 62. 79

WELLS FARGO 5035071327 07/ 24/ 2025 MultDept- Copier Lease 002- 1030- 51110 62. 79

WELLS FARGO 5035071327 07/ 24/ 2025 MultDept-Copier Lease 002- 1065- 51110 62. 79
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WELLS FARGO 5035071327 07/ 24/ 2025 MultDept- Copier Lease 002-1070-51110WELLSFARGO62.795035071327 07/ 24/ 2025 MukDept- Coplerlease 002- 1080- 51110 62. 79WELLS FARGO 5035071327 07/ 24/ 2025 Mu' Wept- Copier Lease 002- 1085- 51110WELLSFARGO7.905035071327 07/ 24/ 2025 MutDept- Copier Lease 002- 1100- 51110 62. 79WELLS FARGO 5035071327 07/ 24/ 2025 MultDept- Copier Lease 002- 1109- 51110 62. 79WELLS FARGO 5035071327 07/ 24/ 2025 MultDept- Copler Lease 002- 1110- 51110 62. 79WELLS FARGO 5035071327 07/ 24/ 2025 MultDept- Copler Lease 002- 1114- 51110 7. 84WELLS FARGO 5035071327 07/ 24/ 2025 MultDept- Copier Lease 002- 1115- 51110 7. 84WELLS FARGO 5035071327 07/ 24/ 2025 MultDept- Copier Lease 002- 1116- 51110 7. 84WELLS FARGO 5035071327 07/ 24/ 2025 MultDept- Copier Lease 002- 1121- 51110 7. 84WELLS FARGO 5035071327 07/ 24/ 2025 MultDept- Copier Lease 002- 1122- 51110 7. 84WELLS FARGO 5035071327 07/ 24/ 2025 MultDept- Copler Lease 002- 1123- 51110 7. 84WELLS FARGO 5035071327 07/ 24/ 2025 MultDept- Copler Lease 002- 1124- 51110 7. 84WELLS FARGO 5035103772 07/ 24/ 2025 Library- Copier Lease 034- 1125- 51110 88. 00

Purchased From Vendor WELLS FARGO Total: 653. 10

Purchased From Vendor.WOODRUM CONSTRUCTION LLC
WOODRUM CONSTRUCTION 7015 07/ 24/ 2025 R& B- HAULING CR TO ROAD 010- 1150- 52320 6, 993. 22

Purchased From Vendor WOODRUM CONSTRUCTION LLC Total: 6, 993. 22

Grand Total:     167, 523. 11.
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The Rains County Commissioners Court Approved and Signed the Payment of Accounts

this g4-11/ day of jw 20

Brent D. Hilliard, County Judge Je y ook, Commissioner, Precinct. 1

Va.  9, 1,0L 1z
Mike Willis, Commissioner, Precinct. 2 KoreyYoung,g, Commissioner, Precinct. 3

X211t2 few,     e.
Lori Northcutt, Co issione , Precinct A Tammi Byrd, County A or
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County of Rains
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Office of

Joe Parker

Emergency Management Coordinator

Environmental Enforcement

Floodplain Administrator

July 8, 2025

To:

Judge Brent Hilliard

Commissioner Mike Willis

Commissioner Korey Young

Commissioner Jeremy Cook

Commissioner Lori Northcutt

Auditor Tammi Byrd

Kristi Hopkins

RE: Rains County OSSF / Designated Representative  ( DR)
Dear Judge and Commissioners,

As you' re all aware, we recently underwent an audit of our On- Site Sewage Facility ( OSSF) practices and
procedures conducted by TCEQ. This audit was initiated due to a complaint— something the auditor
ultimately acknowledged. While we all understand the likely source of that complaint, I' m pleased to
report that the audit found us in full compliance with all TCEQ regulations. The auditor did, however,
recommend that we improve our logging of complaints and applications, which we have since addressed.

During our discussion with the auditor, we explained our current Designated Representative( DR)
situation and our intent to separate the Environmental and Emergency Management departments. He
suggested that we consider using an independent DR contractor. He even provided names of contractors
currently serving neighboring counties and encouraged us to explore that option. Kristi has already
spoken with two of them by phone, and I' ve personally met with one.
Background:

As you know, we' ve made multiple attempts to hire a qualified DR who is also a Code Enforcement Officer
CPO), someone capable of both enforcing regulations and handling OSSF responsibilities. However,

attracting such a dual- qualified candidate at a salary the county can afford has proven extremely difficult.



Hiring and training two separate individuals would be costly and inefficient. We' ve all seen the
considerable effort it' s taken to keep Rains County compliant with TCEQ, TDEM, and our own regulations.

As the county continues to grow, separating the two departments will only become more important— and
finding that" perfect fit" will only get harder.

Proposal:

The contractor I met with has extensive experience and currently provides full DR services to six counties,

including Wood County. His company employs six DRs, covers all related expenses, and carries full
insurance. Each county has its own preferred logistical procedures, but the core OSSF process remains
consistent and aligned with TCEQ standards.

This contractor would become our point person for all OSSF- related matters. They would handle
constituent inquiries, consult with Commissioners and Jason on subdivision matters, respond to

complaints, and— if we choose— submit monthly reports to TCEQ. They prefer that all OSSF- related

questions be directed to them directly.

Their service fees are$ 300 per residential application and$ 400 per commercial. Given our current fee
structure of$ 400 and$ 600, the county would still retain a net profit per application. They do not charge

for handling inquiries or complaints— only for installations.

Logistics:

After discussions with Tammi, we propose continuing to accept applications and payments through the

County Clerk' s Office. Glenda would pick them up, assign permit numbers, and forward them to the DR
contractor via email. The contractor would then review, coordinate with installers, issue approvals, and

send final documents back to Glenda for our records. At month' s end, they would invoice us for the

number of installations completed, and we would issue payment accordingly.

Key Benefits:

1. Simplified budgeting: No salaries, insurance, or benefits— just a cost- per- install basis with predictable
revenues.

2. Clear point of contact: Commissioners and staff can direct all OSSF- related inquiries to the contractor.
3. Streamlined operations: The contractor handles all interaction with installers and constituents.

4. Improved record- keeping: Centralized, consistent documentation and communication.
5. Professional oversight: Experienced, insured professionals accountable to both TCEQ and Rains County.

6. Staff efficiency: Kristi and I can focus fully on our primary duties.
7. Environmental enforcement: In collaboration with the Sheriff' s Office, we would identify a deputy to

serve as our dedicated Environmental and Code Enforcement Officer— someone already within their

budget and trained accordingly.

Please let me know if you would like to proceed with more formal quotes or a draft agreement from the
contractor. I believe this step will greatly benefit the county in terms of compliance, cost- efficiency, and
professional service delivery.

Respectfully,

Joe Parker

Emergency Management Coordinator

Environmental Enforcement

Floodplain Administrator



CONTRACT FOR SERVICES

On- Site Sewage Operations

This Contract for Services is made by and between Rains County Commissioners Court,
hereinafter referred to as the" County," located at 167 Quitman St., Emory, TX 75440, and
Ronnie Stuard, located at 2746 Hwy 271 S., Pittsburg, Texas 75686- 5954„ hereinafter
referred to as the " Contractor." The purpose of this contract is to engage the Contractor to
serve as the Designated Representative for Rains County under the rules and regulations of
the Texas Commission on Environmental Quality( TCEQ), regarding On- Site Sewage
Facilities ( OSSF), including but not limited to:

Texas Health and Safety Code, Chapter 366
Title 30, Texas Administrative Code ( TAC), Chapters 285 and 30, Subchapters A and G
Any other applicable state codes or regulations

DUTIES OF THE CONTRACTOR

Issue permits and approve plans to construct, alter, repair, extend, or operate OSSFs in
Rains County.

Verify that OSSF installers are properly registered with TCEQ.
Conduct inspections to ensure compliance with TCEQ rules and the Texas Health and
Safety Code.

Issue notices of violation and file applicable injunctions and/ or legal actions with the
appropriate judicial court and TCEQ.

Maintain proper licensure and authorization from TCEQ to act as the Designated
Representative for Rains County.

Comply with all applicable statutes, rules, and regulations issued by TCEQ or other
regulatory authorities.

Complete all required records, reports, and documentation, except for filing the Monthly
OARS Report, which will be handled by Rains County.
Attend and complete required or necessary training at the Contractor' s own expense.
Provide and maintain a reliable vehicle for contract- related transportation and maintain
automotive liability insurance of no less than $500,000, with proof of insurance to be
submitted to the Rains County Auditor prior to the contract start date.

Wear a County- provided identification badge at all times while performing duties as the
Designated Representative.

Maintain professional liability insurance with a minimum limit of$ 1, 000,000, listing
Rains County as an additional insured party.
Maintain a Fidelity Blanket Bond in the amount of$ 20, 000, covering the Contractor and
any of their assigns.





Proof of insurance and bond must be provided annually or upon renewal to the County
Auditor. Contractor must notify the County of any policy changes or lapses within 10
days of occurrence.

DUTIES OF THE COUNTY

Provide an Administrative Assistant liaison who will collect OSSF applications from the
Rains County Clerk, issue permit numbers, and scan required documents to the
Contractor for review and approval.

After approval and installation, the Contractor will return signed documentation to the
Administrative Assistant, who will finalize County records.

Maintain all equipment, supplies, and files/ records. These shall remain the property of
Rains County and must be returned upon contract termination.

ADDITIONAL PROVISIONS

The Contractor may hire clerical or technical assistants. All technical assistants must be

pre- approved by the County and/ or TCEQ and must be TCEQ- licensed. These
individuals are solely employees of the Contractor and not of Rains County.
The Contractor is an independent contractor and not a partner, employee, or joint
venturer of the County. The Contractor shall indemnify and hold harmless the County
from any and all claims arising from actions taken in connection with this contract. The

County retains all rights and immunities provided by law, including sovereign
immunity. The contractor' s indemnification obligations shall survive termination of this
Contract.

The County is not responsible for damage to the Contractor' s personal property or
injury to the Contractor, their employees, agents, or assigns.

The Contractor shall submit a monthly invoice to Rains County detailing the number of
inspections performed, upon which a Purchase Order will be issued for payment.
Contractor is responsible for all taxes, withholding and compliance with IRS rules as an
independent contractor.

CONFLICT OF INTEREST

The Contractor must certify there is no conflict of interest in connection with services
provided under this contract.

The Contractor may not act as a registered installer in Rains County, nor may they
design OSSF systems or perform site evaluations that they will later inspect.
Consulting services may only be provided if the Contractor does not inspect or approve
the work as a County representative.

INSPECTION AND ENFORCEMENT

All work performed under this contract is subject to inspection by the County and TCEQ.
Contractor must enforce the minimum OSSF requirements set by the County, TCEQ and
other applicable regulatory agencies.





Any deficiency noted by the County or TCEQ must be corrected promptly to prevent
recurrence.

TERM

This contract shall be effective from August 1, 2025, through July 31, 2026.
It may be renewed annually beginning August 1, 2026, upon request of the Contractor

and approval by the County Commissioners Court.

TERMINATION

Either party may terminate this contract with 60 days' written notice.

The County may terminate immediately for failure to perform duties, violation of
contract terms, or inappropriate conduct by the Contractor or their personnel, as
determined solely by the County.

NOTICE TO INSTALLERS AND TCEQ

Upon approval of this Contract for Services, Rains County will notify all identified OSSF
installers in the area and TCEQ of the process change, including the Contractor' s contact
information.

GOVERNING LAW AND VENUE

This Contract shall be governed by and construed in accordance with the laws of the

State of Texas, without regard to conflicts of law principles. Any legal action arising
from this Contract shall be brought exclusively in the state or federal courts located

in Rains County, Texas

SEVERABILITY

If any of this Contract is held to be invalid, illegal, or unenforceable, the remaining
provisions shall remain in full force and effect.

ASSIGNMENT

Neither party may assign or transfer any rights of obligations under this Contract without

the prior written consent of the other party.

NOTICES

All notices required or permitted under this Contract shall be in writing and delivered by
certified mail, return receipt requested, or by email with confirmation of receipt, to the
addresses specified in this Contract( or as updated in writing), Notices shall be deemed
effective upon receipt.





WAIVER

No waiver of any breach of this Contract shall be effective unless in writing ans signed by
the waiving party. Waiver of one breach shall not constitute waiver of any subsequent
breach.

PAYMENT TERMS

The Contractor shall be compensated at the following rates:

Service Type Rate

Single- Family Dwelling 290. 00

Commercial/ Other 490. 00

Re- Inspection 150. 00

ENTIRE AGREEMENT

This document represents the entire agreement between the County and the Contractor. No
oral or other written agreements shall affect the terms stated herein. This Contract may be
amended only by a written instrument signed by both parties.

Contractor- Date

Rains County Judge- Date





ATTEST:

County Clerk





3AM HOLDINGS, LLO

1812 Greenridge Ct

Sulphur Springs, TX

75482- 3641 USA

4387852

djeffpost@gmail. com

Estimate

ADDRESS ESTIMATE# 1998Tierr

Rains County DATE 07/ 11/ 2025

Rains County
PO Box 158

Emory, Texas 75440 USA

PMT METHOD

Check

ACTIVITY QTY RATE AMOUNT

Camerar4 Channel NVR 1 299. 99 299.99T

NVR- P 4ch 40Mbps 4xPoE CMS/ Audio/ 1xHDD/ UL Listed,
Mini

1 U case 1 xHDD@6TB/ NAS/ IP SAN/ Pt 3Yr

Camera: 4TB Hard Thive 1 199. 99 199. 99T

4TB Surveillance Hard Disk Drive, 5400 RPM Class SATA 6
Gb/ s 64MB Cache 3. 5 Inch

Camera_Turret Camera 4 159. 99 639. 96T

4 MP Turret IP with deep learning and built- in mic,
Camera, 2. 8mm, True WDR„ Micro SD Card up to 128GB
Camera_ Turret Mounting Box 4 25. 00 100. 00T

Metal housing for mounting Turret Camera
Camera: Cameralnstallat ìon 4 150. 00 600. 00T

Camera Installation including cable ( up to 100') per camera
and ends

Parts: Battery Backup 1 119. 99 119. 99T
Battery Backup
Dell23Monllor 1 189. 00 189. 00T
Dell 23" Monitor

SUBTOTAL 2, 148. 93

TAX 0. 00

TOTAL
2,14893

Accepted By Accepted Date





Rains County Fraud, Waste, and Abuse Policy

Rains County does not tolerate any form of fraud, waste, or abuse. The County is committed to
upholding the highest standards of legal, ethical, and professional conduct. All violations of law,
County policies, or standards of ethical conduct will be promptly investigated, and appropriate
disciplinary, legal, or corrective actions will be taken.

Policy Statement
Any type of fraud, waste, or abuse is strictly prohibited. All employees, officials,
contractors, and subcontractors are required to comply with applicable laws, regulations,
and Rains County policies on fraud, waste, and abuse.

Reporting Requirements under Texas Government Code Section 321. 022

If the department head of a Rains County office, department, or entity ( subject to audit by
the Texas State Auditor) has reasonable cause to believe that money received from the
State of Texas by Rains County, or by a client or contractor of the County, may have been
lost, misappropriated, or misused— or that other fraudulent or unlawful conduct has
occurred in relation to the operation of the County— the department head must report the

reason and basis for that belief to the Texas State Auditor' s Office ( SAO).

Mandatory Reporting by Employees and Contractors

All Rains County employees, contractors, and subcontractors who become aware of any
suspected fraud, waste, abuse, or questionable activities involving County personnel,
officers, agents, clients, or other contractors are required to immediately report such
activities to the Texas State Auditor' s Office ( SAO). Employees and contractors making
good- faith reports are protected from retaliation under Texas Government Code Chapter
554.

Reports to the SAO may be made by any of the following methods:
SAO Toll- Free Hotline:     Mailing Address:
1- 800- TX- AUDIT Texas State Auditor' s Office

1- 800- 892- 8348)     Attn: Investigations

SAO Website:  P.O. Box 12067

https:// sao. fraud. texas. gov/ Austin, Texas 78711- 2067

Adopted this 24th day of July 2025.

Brent Hilliard, Rains County Judge

WIC.
e Co k, Commissioner Precinct 1 Mike Willis, Commissioner Precinct 2

K rey oung,' Commissio r Precinct 3 LoriNOj   r Commis Toner Precinct 4

Attest:    i 15 f

91 s





Project Cost Estimate

Rains County Courthouse- Condition Assessment May 2025

til`.   ilE;.rd r..,',., i. 7PK[ Yr" t-:,,.       '•, i, ka3`: ,"-.. i..      . ); Y  >. y, W.

o1000 t3EFtt t11L RLMHtwtrS 17% totsIconstructioncost)   456t2 - 4

A. Project Management

B. Field Personnel

C. Construction Documents! Printing

D. Quality Control

E. Temporary Utilities
F. Construction Facilities

G. Bond& Insurance

H. Temporary Construction

1, Scaffolding
2, Project sign

3. Barrier fencing( Staging area, protection, etc...)

I. Materials Testing

Q100O T HAZARQOUS Mf1 S ARA o

None, note original painted sheet metal likely contains lead

BrTE WORt(

A. Earthwork& Grading

1 Fill& compact crroded sea& r ra} bade at ocrinwter of buitdiny for posrtoe
By Cty dr. arrm. qe

B. Paving
PcC fy 1. Replace often& to tu' p expar., ro,, joints wit" 1. m ker rap&' o; I rnt

C. Landscape Restoration( Plants, pruning)

By Cty 1. Relocateartm Omit shrub,. 4- 5` f re to 1411111159 Medium shrub% 33& Small plantirmy 9 2'

2. Yard Irrigation

By Cty a. Relocate,, tar. okler i cad,, 5 Em, mway from foundation

tt Provide soaker hose type{ rvqatron at plantrrrg hack rartrarcnt to holding

By Cty t cmnaahorm

y xr

A. Structural Repairs and Modifications

B. Non- structural

1. Restore concrete foundation stem wall& window sills

a. Remove paint coatings from parge coat 100%       1674 S.F.       3. 50 5, 859

b. Repair cracks in concrete foundation stem wall& window sills with injection

grout 1 LS,   7,500.00 7,500

c. Restore cementitious parge coat; Tool bottom edge of window sills to form
a drip 1674 S.F.      12.00 20,088

d. Apply waterproof coating, silicate based, breathable, to stem wall& window

sills 1674 S.F.       2. 50 4, 185

r 018
A. General Exterior Restoration

1. Selectively re- point brick masonry 500 S.F.      12.00 6, 000

2. Re- set displaced& loose brick 16,  S.F.     250.00 4,000

3. Replace sealant at movement joints, i. e. between building& mechanical well
walls 1 L.S.   1, 000. 00 1, 000

4. Brick absorption testing, test 3- 5 bricks 1 L. S.     750.00 750

5, Apply water repellent coating to brick masonry, based on results of brick
Alternate testing 4905 S.F.       2.50 12, 263

B. Structural repairs/ modifications

1. At southwest quadrant, remove plaster finish at crack locations to expose brick

masonry or concrete structure, repair cracks if they extend into masonry 1 L.S.   2, 500.00 2, 500

2. At 1st south corridor, remove plaster finish at crack location in ceiling to expose
concrete structure, repair cracks if they extend into concrete 1 L.S.   3,500.00 3, 500

CARPENTRY i
4 4'  1

A. Rough Carpentry/ Structural Repairs
1. Reinforce rotted 2X wood bracing in attic 1 Ea,     500. 00 500

B. Finish Carpentry

ARCHITEXAS Page 1 5/ 18/ 2025
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GUARDIAN RFID
WARRIOR 7ECHHOLOOY

DCHP

DCHP is the preferred configuration. If you decide against DHCP then we' ll need a list of the
static IP addresses you' ll be assigning to our devices.  In addition to the static IP addresses we
will also need the Subnet Mask, Default Gateway, DNS, and Alt. DNS. Example: 220.78. 168. 0/ 21
represents IPv4 addresses between 220. 78. 168. 0 and 220. 78. 175. 255. Learn more:

http:// aprelium. com/ data/ doc/ 2/ abyssws- linux- doc- html/ ipformat. html.

2020 GUARDIAN RFID. All rights reserved. GUARDIAN RFID, SPARTAN, Thin Gray Line, and One Team. One Mission. are registered trademarks or
trademarks of GUARDIAN RFID. Patented and patent pending. This configuration guide is confidential and proprietary.



GUARDIANRFID

unauthorized computers from adding data via off-network computers and permits only known
Internet- accessible PCs to use other secure features.

Part 2: Wi- Fi Installation

GUARDIAN RFID requires Wi- Fi coverage, anywhere where officers will be logging information
about inmates during the day- to- day tasks. In many facilities the use of access points may be
required to create a wider Wi- Fi network. Ideally coverage should span the entire facility and
support either the 2. 4Ghz or 5Ghz band.

Recommended access point manufacturers include the following:
Cisco

HP

Aruba

Ruckus

Ubiquiti

Part 3: Wi- Fi Configuration

GUARDIAN RFID supports a wide array of network configurations. The following is a list of
compatible setup configurations.

MAC Filtering
Mac filtering may either be enabled or disabled. If mac filtering is enabled, GUARDIAN RFID will
supply a list of all SPARTAN MAC addresses prior to deployment.

Authentication

WPA, Open, Shared, WPA- PSK, and WPA- 2- PSK authentication protocols may be used.

Encryption

Both AES and TKIP encryption standards are supported.

SSID

SSID may be either broadcasted or hidden. Each access point may share a SSID or have their
own unique SSID.

@ 2020 GUARDIAN RFID. All rights reserved. GUARDIAN RFID, SPARTAN. Thin Gray Line, and One Team. One Mission. are registered trademarks or
trademarks of GUARDIAN REID. Patented and patent pending. This configuration guide is confidential and proprietary.
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WI- Fl REQUIREMENTS • CONFIGURATION

GUARDIAN RFID helps officers log inmate activity. Officers will carry around Android devices
throughout the day and will log inmate behaviors, movements, supplies, etc. These logs are
automatically sent via Wi- Fi to our Cloud ( US- based, CJIS compliant). From our cloud- based app,
your command staff will be able to view reports and display real- time dashboards. The following
is an overview of the GUARDIAN RFID Wi- Fi connection requirements.

Part 1 Firewall Updates

GUARDIAN RFID will be sending and receiving data at your facility. This data flow will require the
following ports and addresses to be approved on your firewall.

Your Firewall

In order to ensure proper operation, the following addresses need to be added to your network' s
approved list.

https:// www. GUARDIANondemand. com ( 161. 47.108. 242)

sftp:// sftp.GUARDIANondemand.com (161. 47.108.242)
http:// logmeinrescue- enterprise. com (69. 25. 20. 0/ 23)

https:// mdm.GUARDIANondemand. com (15. 200.119. 231)

Websocket Secure ( wss://) is allowed

Unspam emails from © GUARDIANrfid. com

Allow NTP ( Port 123) to 2.android.pool.ntp.org

http:// update. bluebirdcorp. com

fabric. io ( Port 80 and 443)

crashlytics. com ( Port 80 and 443)

play. googleapis. com ( Port 80 and 443)
www.googleapis.com (Port 80 and 443)
android. googleapis. com ( Port 443, 5228, 5229, 5230)
https:// GUARDIANrfid. com

activate. 42gears. com ( 65. 52. 54.49, Port 80, Port 443)

GUARDIAN RFID Firewall

For security purposes, GUARDIAN RFID will require each unique Wide Area Network IP address in
use at your facility. We will be updating our firewall with this IP address and will restrict any

2020 GUARDIAN RFID. All rights reserved. GUARDIAN RFID, SPARTAN, Thin Gray Line, and One Team. One Mission. are registered trademarks or
trademarks of GUARDIAN RFID. Patented and patent pending. This configuration guide is confidential and proprietary.



GUARDIAN RFID

OVERVIEW

GUARDIAN RFID® helps correctional agencies digitally transform their team so as to maximize compliance,
defensibility, and productivity. Our objective is to empower corrections professionals to work safer, smarter,
and more aware with our Command& Control platform, comprised of sensors, mobile, and Cloud technology.

ABOUT THIS DOCUMENT

This GUARDIAN RFID Integration Guide discusses support for one- way and two- way integration with jail,
records, and case management systems— whether homegrown or from a public safety independent
software vendor( ISV).

If you have any questions regarding this document or integrating with GUARDIAN RFID, please contact:

Mark Thomson

support ? guardianrfid. com
866) 382- 6339, opt. 2

COMMONLY USED TERMS

Abbreviations such as JMS, OMS, and RMS may routinely appear throughout this documentation. This is in
reference to Jail Management System, Offender Management System, and Records Management Systems,
respectively.

PAGE 2
02024 GUARDIAN RFID. All rights reserved. GUARDIAN RHO, SPARTAN, Thin Gray Line, and One Team, One Mission

are registered trademarks or trademarks of GUARDIAN RFID. Patented and patent- pending. CONFIDENTIAL AND PROPRIETARY



GUARDANRFID

HOW TO SEND ) MS DATA TO GUARDIAN RFID
Simple Text File)

The flat file interface consists of a periodic windows service that sends:

1. Inmate Information(. txt)

2. Mugshots(. jpeg)
3. Special Status(. txt)

4. Keep Separates(. txt)

These files are to be sent every 3- 5 minutes to GUARDIAN RFID' s secure FTP server in the designated
directories.

JMS Server ( Not GUARDIAN)  GUARDIAN RFID Servers

Database Service

Service extracts FIREWALL r{  SFTP Server upserts data to

flat- file I       \\\\\\       
J database

every 2-5 min)

T 1
Service

exports. jpeg Booking#(

upon change) Name
Sync Server

SQL Server

Demographics

Housing
Etc.

Mugshot I Agency LAN
image

r

Service sends
Mobile App Web App

files via SFTP

PAGE 3
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are registered trademarks or trademarks of GUARDIAN RFID. Patented and patent- pending. CONFIDENTIAL AND PROPRIETARY,
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INMATE INFORMATION

Please create this flat- file service from scratch. In order to create this service, you will need to:

1. Locate the database where your JMS data resides
2. Create an extract service that creates a flat file( Fixed Column Only)
3. Create ajob that runs this services every 3- 5 minutes
4. Ensure that the output file is named JMASTER[ date time of creation]. txt( case sensitive,

e.g.: JMASTER03022012152315. txt)
5. Request the SFTP connection site, credentials, and directory from GUARDIAN RFID
6. Create a windows service that sends the! MASTER file

The! MASTER file should be a current snapshot of all the inmates in the facility with a housing assignment at
the time the file was generated. The file should only contain inmates that are booked into the jail that have an
assigned housing assignment.

Format Requirements: 

Feld Description Length

Booking Number Unique number that identifies an 11

inmate for each booking. Required
Name The inmate' s full name as 31

LastName, FirstName MiddleName) If
an inmate has more than one last

name please put a hyphen between
the names. Required

Date of Birth Supply the date of birth as( MM/ DO/  9

YY) with a space at the end.

Race 1- 2 character code. i.e. W 2

Sex M or F with a space at the end 2

Height Supply as 6' 02" with a space at the 6
end

Weight 4

Color of Hair 4

Color of Eyes 4

JRN This is a unique number that 11
identifies the inmate for all of the

inmates bookings. The booking
number may be submitted again, if
needed. Required

Mugshot File The name of the mugshot file i. e.     21

BookingNumberj. jpg
Active Supply Y with 4 spaces after it.       5

Required

Housing Assignment A unique code that represents the n/a

assigned housing. i. e. Cell 01,
193456, C101 This column can be as
long as needed. Please remove any
white space at the end. Required

Example: _  

JM1ASER042r05091240. 1XT
05- 00001 Smsth, John 07/ 01/ 53 W M 6' 00" 200 DLO 6RN JRN- 00001 Y I11A1005- 00034 Derks, Jeffrey 04/ 13/ 90 W M 5' 05" 161 ORO OLU JRN- 00034 Y 11201005- 00011 Attan, Scott 03/ 11/ 76 W r1 6' 10" 195 OLA ORO JRN- 00011 Y II3C0105- 00014 Wilson, Jessica 09/ 29/ 79 W r 5' 04" 133 ORO OLU 1RN- 00014 V H3F0305- 00041 Jacknan, filly 10/ 01/ 80 W M 5' 01" 156 CIA DRS 1RN- 00041 Y htmle
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MUGSHOTS

Please create this image service from scratch. In order to create this service, you will need to:

1. Locate the database where your JMS data resides
2. Create an extract service that pulls front- facing mugshots any time there is a new booking or a

change in mugshot

3. Create a job that runs this services every 3- 5 minutes
4. Ensure that the output file is named with an inmate identifier( e.g.:[ BookingNumber],jpg)
5. Request the SFTP connection site, credentials, and directory from GUARDIAN RFID
6. Create a windows service that sends image file

Format Requirements:     --

The mugshot files should be in a standard format(. jpg,. png,. gif). Extension( ex.. JPG or. jpg) must be consistent,
either all upper case or all lower case.
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SPECIAL STATUS

Please create this flat file service from scratch. In order to create this service, you will need to:

1. Locate the database where your JMS data resides
2. Create an extract service that creates a flat file( NOTE: this should be a CSV file)

3. Create a job that runs this services every 3- 5 minutes
4. Ensure that the output file is named[ Special_ Status][ date time of creation]. txt

5. Request the SFTP connection site, credentials, and directory from GUARDIAN RFID
6. Create a windows service that sends the Special Status file

This file will include all active inmates with a hazard, special status, or restriction( e. g.: Suicide Watch,
Dangerous to Others, Escape Risk, Lockdown, and No Visitation). Any restriction that is omitted from this
file will be recognized in GUARDIAN RFID as a deactivation of the restriction.

Format Requirements:

Field Description

Record_ ID Each row must have a Static Unique ID

Booking Inmate Booking Number

JRN Inmate Permanent Number

Hazard_ Code Code to identify the type of hazard( 1 or 2
characters)

Hazard_ Literal Description of the hazard. i. e. Dangerous to

Others

Start_ Date Date the hazard starts i. e.( 08/ 13/ 2021)

Start_ Time Time the hazard starts i. e.( 12: 19: 52)

Authorized_ by_Operator, null JMS user id or officer number of the user that
authorized the hazard

Clear_ Date, null Date the hazard ends

Clear_Time, null Time the hazard ends

Cleared_ by_Operator, null JMS user id or officer number of the user that

cleared the hazard

Remarks, null notes about the hazard( Remove any Returns
and Commas)

Example: — 

lo Re'SWCtionS       ..

79003001, 142698, 73792, G, Gang Member, 09/ 17/ 2014, 10: 46: 00, 2415,,,," Murder Inc CCD"

79003002, 142698, 73792, G, Gang Member, 09/ 17/ 2014, 10: 46: 30, 2115,,,," TRU - CCDC"

79301001, 142691, 108633, SG, Suspected Gang Member, 10/ 15/ 2016, 12: 10: 33, 2115,,,," DMI"

79303013, 144114, 38633, G, Gang Member, 08/ 17/ 2014, 10: 47: 11, 5225,,,," TRU - CCDC"

79304122, 143314, 100633, G, Gang Member, 08/ 17/ 2015, 11: 12: 10, 1325,,,," TRU - CCDC"
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KEEP SEPARATE

Please create this flat file service from scratch. In order to create this service, you will need to:

1. Locate the database where your JMS data resides
2. Create an extract service that creates a flat file( NOTE: this should be a CSV file)

3. Create ajob that runs this services every 3- 5 minutes
4. Ensure that the output file is named[ KeepSeparate][ date time of creation]. txt
5. Request the SFTP connection site, credentials, and directory from GUARDIAN RFID
6. Create a windows service that sends the KeepSeparate file

This file will include all active inmates that have an active keep separate from another active inmate. Any keep
separate that is omitted from this file will be recognized in GUARDIAN RFID as a deactivation of the restriction.

Format Requirements:

Field Description

Record_ ID Each row must have a Static Unique ID

Booking Inmate Booking Number

JRN_ must_ be_ kept_ away_ from Inmate Permanent Number of the inmate

same as booking above)

JRN Inmate Permanent Number of the other

inmate

Start_ Date Date the keep separate starts( can include
time) ' Required

End_ Date Date the keep separate ends( can include
time) ' add Null if no End_ Date

Example:

Keep SeparateD8232U21O5C914PM. bt- Notepad

File Edit Format View Help

h854, 133989, 425608, 428753, 2319- 10- 22, NULL
3855, 105989, 425608, 433674, 2019- 10- 22, UULL

3894, 135989, 425608, 432155, 2019- 10- 22, FU1L

3934, 126142, 311544, 432155, 2019- 12- 17, NULL

3935, 106142, 311544, 23628@, 2019- 12- 17, MULL

3974, 186451, 414630, 432155, 2020- E4- 25, NULL

3995, 108451, 414630, 429816, 2020- 134- 25, FNULL
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USAGE

Once GUARDIAN RFID starts receiving data from your 1MS, staff will be able to leverage powerful features
within the GUARDIAN RFID mobile application( Mobile C ranja! el and web app( cIaOewar tJ=l.

GUARDIAN RFID offers business hour helpdesk support and 24/ 7 service monitoring on all JMS interfaces.

support@guardianriki. com

866) 382- 6339, opt. 2

REQUIREMENTS

In order to create this interface, you will need:

1. Administrative access to your 1MS data so as to extract data
2. Administrative access to your firewall so as to enable SFTP traffic( option 1)

LICENSE

This interface is not licensed and GUARDIAN RFID does not charge a fee for supporting the" JMS Sends Data
to GUARDIAN RFID" interface build. However, some 1MS providers will charge a fee for granting extract access.
Please contact your JMS provider to ensure that this service was purchased.
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PULLING DATA FROM GUARDIAN RFID

2- Way: SOAP API)

Pulling information from GUARDIAN RFID is not a complimentary service, please confirm with your GUARDIAN
RFID account executive to ensure that this service was purchased.

INSTALLATION

In order to access the GUARDIAN RFID SOAP API, you will need to obtain the correct URL from support:
Support@GuardianRFlD. com.

The easiest way to access the Guardian Web Service is with a SOAP API tool such as SoapUl.

Startup SoapUl and choose File-> New SOAP Project. Enter a Project name and the correct

URL for your facility and click OK.

New SOAP Project X

New SOAP Project
r

Creates a'."` ISDL/ SOAP based Project in this workspace 0 5

i €
Project Name:    Guardian Web Service 1

Initial WSDL:     Ihttp:I/yuardian asn , Browse .

Create Requests: L11 Create sample requests for all operations?

Create TestSuite: E Creates a TestSuite for the imported WSDL

Relative Paths:   El Stores all file paths in project relatively to project file( requires save)

i OK} rCanccl

A folder will be added to the tree view on the left. To get Activity Log data, expand GetActivityLog and
double- click on Request 1 and a window will open with a SOAP template.
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CreatelmageStub

i-'     GetActrvityLog'.
Request 1

GetCellCheckData

i+=  GetCommissaryData

GetConfigSetting
i GetConfinementData

GetlnmatesWithOldPhotos

Get1MSConfigSetting

GetMedicallog
GetMedicationData

1 GettvloveData

GetTiburcnEventLeg
GetTransportData

HelloWorld

572, SendGenericlnmateRoster

r, SendlnmateCISRcster

SendhimateCrimeStarRoster

r SendlnmateHazards

t SendlnmateHillCountyRoste

SendinmateNewWorldRoster

r SencilnmatePhctos

SendlnmateRestrictions

SendlnmateRoster

s SendlnmateTigerRoster

SendlnterfaceSetup
SendKeepSeparate

4:3 SendtvledicationRoster

r SendOfficerRoster

TestConnection
ii

Fri-     UpdateConfigSetting
UpdatelnmatePhotos

r±   i Update. IMSConfigSetting
Version r

Enter your CustomerlD, Password, and a Starting Date( MinDate) m/ d/ yyyy. Click the green submit button to
return Activity Log response from MinDate to present.
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scAp: Err! sic. pe L

1 sty

GetActIty: zgAesp: nse

CL:    1Ler.ActiviLogPesult

017- 0Z-:,:.  E-

juar-LI:L= LL

L:• 17:-%  L

L^.      "

1" : 4

En-L. 1'T

Ps*-Lring

V1. 174•42-.

4 All

LL: 11: 1Ln ri, L:

77.7-

1

z•.=

7, 1 17: 7;

J.

Lie

INMATE ACTIVITY LOGS

CONFINEMENT

USAGE

Once your JMS starts receiving data from GUARDIAN RFID, staff will be able to log into the JMS and see all
of the logs they captured on GUARDIAN RFID' s mobile application( tilobile Commandil) and web app
OnDernandl.

GUARDIAN RFID offers business hour helpdesk support and 24/ 7 service monitoring on all JMS interfaces.

support© guardianrfid. com
866) 382- 6339, opt. 2

WARNING: GUARDIAN RFID is NOT responsible for any JMS use cases beyond sending data to the temp table.
If your team would like the JMS to use GUARDIAN RFID data in a specific way, then you will need to contact
your JMS provider.
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TEST CONNECTION

The following call tests your connection TestConnection(CustomerlD,Password)( function variables are strings).

Sample Return:

soap: Envelope xmins: soap=" http:/ schemas. xmisoap. org/ soap/ envelope/"
xmins: xsi=" http:/ www.w3. org/ 2001/ XMLSchema- instance" xmins: xsd=" http:/
www. w3. org/ 2001/ XMLSchema">

soap: Body>
TestConnectionResponse xmins=" http:/ tempuri. org/">
TestConnectionResult> false</ TestConnectionResult>

TestConnectionResponse>

soap: Body>
soap: Envelope>

GET ACTIVITY LOG

The following call returns all logs that officers have captured using GUARDIAN RFID' s readers
GetActivityLog( Customerl D, Passwo rd, mi nDate).

Fields will include:

Activity Log
Activity ID
Activity Title
Activity Type( example: Round, Movem, Count, Meals)
Activity Description( limit: 8000 characters)

NOTE: In the current version, out- of- cell destinations need to be parsed from activity description string.

Activity Date Time
Insert Date Time

Housing Location
Inmate ID

Officer Badge Number

Event codes, include:

CLCK

OTCL

INCL

SECK

HDCT

MEAL

GENR

OFFC

RECR
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Sample Return:

soap: Envelope xmins: soap=" http: Ischemas. xmisoap. org/ soap/ envelope/"
xmins: xsi=" http: Iwww. w3. org/ 2001/ XMLSchema- instance" xmins: xsd=" http:!
www. w3. org/ 2001/ XMLSchema">

soap: Body>
GetActivityLogResponse xmins=" http:9tempuri.org/">
GetActivityLogResult>< I[ CDATA[< DocumentElement>

EventLogEntry>
ActivityLogUID> 528aca09- 357c- 47a0- 9eaa- ba2eb259095f</ ActivityLogUID>

DateTimeString> 2017- 07- 03 16: 05:43</ DateTimeString>
OfficerNbr2> 9999</ OfficerNbr2>

Name> Officer 9999 has logged into the Guardian Desktop.</ Name>

Code> OFFC</ Code>

EventDescription> 0fficer Log in/ out</ EventDescription>

InsertDateString> 2017- 07- 03 16:05:43</ InsertDateString>
EventLogEntry>
DocumentElement>]]></ GetActivityLogResult>

GetActivityLogResponse>

soap: Body>
soap: Envelope>

EXAMPLES OF GetActivityLog FOR MOVEMENT

Inmate from Chaplin: ------_.__.. __ .. ___     

EventLogEntry>
ActivityLogUID> c379c1a3- d776- 445e- 9ad0- 01f3ea6fffe0</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 13: 27</ DateTimeString>
OfficerNbr2> 9999</ OfficerNbr2>

Narne>** From Chaplain</ Name>

BookingN pr> IN201800017</ BookingNbr>

Location> B- 10- L</ Location>

LocationlD> 480</ LocationlD>

Type> Cell</ Type>

Code> INCL</ Code>

EventDescription> Back to Ceil</ EventDescription>

InsertDateString> 2019- 06- 05 12: 13: 36</ InsertDateString>
SSN> 414958</ SSN>

EventLogEntry>
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Inmate from Clinic: a

EventLogEntry>
ActivityLogUID> 5fe1a24b- a299- 4625- 9286- 1 c9f9473b2e5</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 13: 27</ DateTimeString>
0fficerNbr2> 9999</ 0fficerNbr2>

Name>** From Clinic</ Name>

BookingNbr> IN201800009</ BookingNbr>

Location> B- 06- L</ Location>

LocationlD> 472</ LocationlD>

Type> Cell</ Type>

Code> INCL</ Code>

EventDescription> Back to Cell</ EventDescription>

InsertDateString> 2019- 06- 05 12: 13: 36</ InsertDateString>
SSN> 423492</ SSN>

EventLogEntry>

Inmate from GED:    

EventLogEntry>EventLogEntry>
ActivityLogUID> e3dc04d3- b67f- 4443- 9c9d- b0a7f68201 c5</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 13: 27</ DateTimeString>
OfficerNbr2> 9999</ 0fficerNbr2>

Name>** From GED</ Name>

BookingNbr> IN201700005</ BookingNbr>

Location> B- 02- U</ Location>

LocationlD> 465</ LocationlD>

Type> Cell</ Type>

Code> INCL</ Code>

EventDescription> Back to Cell</ EventDescription>

InsertDateString> 2019- 06- 05 12: 13: 36</ InsertDateString>
SSN> 426328</ SSN>

EventLogEntry>

Not an Out of Cell Movement:

EventLogEntry>
ActivityLogUID> 1437d98f- 12a2- 45d8- beff- db202bc7d28b</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 13: 27</ DateTimeString>
0fficerNbr2> 9999</ 0fficerNbr2>

Name>** Bunk/ Locker Search Contraband Found Exercising</ Name>

BookingNbr> 13- 67730</ BookingNbr>

Location> B</ Location>

LocationlD> 3001</ LocationlD>

Type> Section</ Type>

Code> CLCK</ Code>

EventDescription> Cell Check</ EventDescription>

InsertDateString> 2019- 06- 05 12: 13: 49</ InsertDateString>
SSN> 908786</ SSN>

EventLogEntry>
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Back to Cell: --

EventLogEntry>
ActivityLogU I D> 15f91 ced- 117 b- 4acd- 9b20- ed 1482fa89e3</ ActivityLogU I D>

DateTimeString> 2019- 06- 05 12: 13: 27</ DateTimeString>
0fficerNbr2> 9999</ 0fficerNbr2>

Name>** From Clinic</ Name>

BookingNbr> IN201800012</ BookingNbr>

Location> B- 03- L</ Location>

LocationlD> 466</ LocationlD>

Type> Cell</ Type>

Code> INCL</ Code>

EventDescription> Back to Cell</ EventDescription>

InsertDateString> 2019- 06- 05 12: 13: 36</ InsertDateString>
SSN> 408874</ SSN>

EventLogEntry>

Inmate to Church:

EventLogEntry>
ActivityLogUID> 6d7c0cb6- 5aec- 47a2- a944- ba027be4c0a5</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 14: 42</ DateTimeString>
OfficerNbr2> 9999</ 0fficerNbr2>

Name>*** To Church</ Name>

BookingNbr> IN201800019</ BookingNbr>

Location> Church</ Location>

LocationlD> 5134</ LocationlD>

Type> Cell</ Type>

Code> OTCL</ Code>

EventDescription> Out of Cell</ EventDescription>

InsertDateString> 2019- 06- 05 12: 14: 51</ InsertDateString>
SSN> 422896</ 55N>

EventLogEntry>

Inmate to Medical:

EventLogEntry>
ActivityLogUID> a02c26e8- 66e0- 4450- a6b7- c4fcab368427</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 14: 50</ DateTimeString>
0fficerNbr2> 9999</ 0fficerNbr2>

Name>*** To Medical</ Name>

BookingNbr> IN201800009</ BookingNbr>

Location> Medical</ Location>

LocationlD> 5144</ LocationlD>

Type> Cell</ Type>

Code> OTCL</ Code>

EventDescription> 0ut of Cell</ EventDescription>

InsertDateString> 2019- 06- 05 12: 15: 13</ InsertDateString>
SSN> 423492</ SSN>

EventLogEntry>
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Not a Movement- Inmate Cell Check:

EventLogEntry>
ActivityLogUID> eb0fb623- 25b9- 4f56- bc98- 518b220e4c9f</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 14: 50</ DateTimeString>
OfficerNbr2> 9999</ 0fficerNbr2>

Name>*** Approved Movement To Medical</ Name>

BookingNbr> IN201800009</ BookingNbr>

Location> B- 06- L</ Location>

LocationlD> 472</ LocationlD>

Type> Cell</ Type>

Code> CLCK</ Code>

EventDescription> Cell Check</ EventDescription>

InsertDateString> 2019- 06- 05 12: 15: 13</ InsertDateString>
SSN> 423492</ SSN>

EventLogEntry>

Inmate to County Court:

EventLogEntry>
ActivityLogUID> ffe7c5a9- 2298- 4008- 8821- e80226fadf22</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 15: 03</ DateTimeString>
0fficerNbr2> 9999</ OfficerNbr2>

Name>*** To County</ Name>

BookingNbr> IN201700077</ BookingNbr>

Location> County</ Location>

LocationlD> 5164</ LocationlD>

Type> Cell</ Type>

Code> OTCL</ Code>

EventDescription> Out of Cell</ EventDescription>

InsertDateString> 2019- 06- 05 12: 15: 13</ InsertDateString>
SSN> 426416</ SSN>

EventLogEntry>

Inmate to Recreation( Using Out of Cell Option): --- -  

EventLogEntry>
ActivityLogUID> 9b31 d1 ec- ab75- 4220- a3f5- 407b9718609f</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 15: 11</ DateTimeString>
0fficerNbr2> 9999</ OfficerNbr2>

Name>*** To A Pod Rec</ Name>

BookingNbr> IN201800012</ BookingNbr>

Location> A Pod Rec</ Location>

LocationlD> 5153</ LocationlD>

Type> Cell</ Type>

Code> OTCL</ Code>

EventDescription> Out of Cell</ EventDescription>

InsertDateString> 2019- 06- 05 12: 15:28</ InsertDateString>
SSN> 408874</ SSN>

EventLogEntry>
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Inmate to Child Support Class:

EventLogEntry>
ActivityLogUID> 4242d3b3- 133b- 4e06- a4e5- 129d696cc7ac</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 15: 28</ DateTimeString>
OfficerNbr2> 9999</ 0fficerNbr2>

Name>*** To Child Support</ Name>

BookingNbr> IN201800017</ BookingNbr>

Location> Child Support</ Location>

LocationlD> 5146</ LocationlD>

Type> Cell</ Type>

Code> OTCL</ Code>

EventDescription> 0ut of Cell</ EventDescription>

InsertDateString> 2019- 06- 05 12: 15: 47</ InsertDateString>
SSN> 414958</ SSN>

EventLogEntry>

Inmate Return from Child Support Class:  — 

EventLogEntry>
ActivityLogUID> 740fbb06- 5510- 486e- 88a3- 6a7ed360fae7</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 15: 39</ DateTimeString>
OfficerNbr2> 9999</ OfficerNbr2>

Name>*** From Child Support</ Name>

BookingNbr> IN201800017</ BookingNbr>

Location> B- 10- L</ Location>

LocationlD> 480</ LocationlD>

Type> Cell</ Type>

Code> INCL</ Code>

EventDescription> Back to Cell</ EventDescription>

InsertDateString> 2019- 06- 05 12: 15: 56</ InsertDateString>
SSN> 414958</ SSN>

EventLogEntry>

Inmate Return from Court:       

EventLogEntry>
ActivityLogU I D> 1 dc94ee2- af9e- 4414- 826e- e4cd4ca92bf4</ ActivityLogUl D>

DateTimeString> 2019- 06- 05 12: 15: 40</ DateTimeString>
OfficerNbr2> 9999</ 0fficerNbr2>

Name>*** From County</ Name>

BookingNbr> IN201700077</ BookingNbr>

Location> B- 07- U</ Location>

LocationlD> 475</ LocationlD>

Type> Cell</ Type>

Code> INCL</ Code>

EventDescription> Back to Cell</ EventDescription>

InsertDateString> 2019- 06- 05 12: 15:56</ InsertDateString>

SSN> 426416</ SSN>

EventLogEntry>
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Inmate Return from Recreation( Out of Cell Module Option):

EventLogEntry>
ActivityLogUID> 94cf80e0- 9af8- 4f07- 8284- 8c2f5b5f5545</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 15: 41</ DateTimeString>
0fficerNbr2> 9999</ 0fficerNbr2>

Name>*** From A Pod Rec</ Name>

BookingNbr> IN201800012</ BookingNbr>

Location> B- 03- L</ Location>

LocationlD> 466</ LocationlD>

Type> Cell</ Type>

Code> INCL</ Code>

EventDescription> Back to Cell</ EventDescription>

InsertDateString> 2019- 06- 05 12: 15: 56</ InsertDateString>
SSN> 408874</ SSN>

EventLogEntry>

Inmate Return from Church: —

EventLogEntry>
ActivityLogUID> 2379f8ec- 4777- 4cde- 8505- d21f2d336749</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 15: 42</ DateTimeString>
0fficerNbr2> 9999</ 0fficerNbr2>

Name>*** From Church</ Name>

BookingNbr> IN201800019</ BookingNbr>

Location> B- 05- L</ Location>

LocationlD> 470</ LocationlD>

Type> Cell</ Type>

Code> INCL</ Code>

EventDescription> Back to Cell</ EventDescription>

InsertDateString> 2019- 06- 05 12: 15: 56</ InsertDateString>
SSN> 422896</ SSN>

EventLogEntry>

Inmate Return from Chaplin:

EventLogEntry>
ActivityLogUID> cb244f25- 4de0- 4874- 8af2- 467372d5f751</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 15: 58</ DateTimeString>
0fficerNbr2> 9999</ 0fficerNbr2>

Name> NSit From Chaplain</ Name>

BookingNbr> IN201800036</ BookingNbr>

Location> C- 03- L</ Location>

LocationlD> 488</ LocationlD>

Type> Cell</ Type>

Code> INCL</ Code>

EventDescription> Back to Cell</ EventDescription>

InsertDateString> 2019- 06- 05 12: 16: 16</ InsertDateString>
SSN> 423462</ SSN>

EventLogEntry>
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Inmate Return from Medical

EventLogEntry>
ActivityLogUID> a063f669- 47fb- 4116- b4b1- 0ad880653490</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 15: 58</ DateTimeString>
0fficerNbr2> 9999</ 0fficerNbr2>

Name> NS# From Medical</ Name>

BookingNbr> IN201800009</ BookingNbr>

Location> B- 06- L</ Location>

LocationlD> 472</ LocationlD>

Type> Celk/ Type>

Code> INCL</ Code>

EventDescription> Back to Cell</ EventDescription>

InsertDateString> 2019- 06- 05 12: 16: 16</ InsertDateString>
SSN> 423492</ SSN>

EventLogEntry>

Inmate Decline Recreation Using Recreation Module:       

EventLogEntry>
ActivityLogUID> 421 e4d3e- f9dc- 4401- a172- 0c31a8d95507</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 16: 15</ DateTimeString>
0fficerNbr2> 9999</ 0fficerNbr2>

Name>** Declined Recreation( Recreation)</ Name>

BookingNbr> 13- 67730</ BookingNbr>

Location> B</ Location>

LocationlD> 3001</ LocationlD>

Type> Section</ Type>

Code> RECR</ Code>

EventDescription> Recreation</ EventDescription>

InsertDateString> 2019- 06- 05 12: 16: 58</ InsertDateString>
SSN> 908786</ SSN>

EventLogEntry>

Inmate Accept Recreation( Recreation Module Option):

EventLogEntry>
ActivityLogUID> c37f8b76- 4735- 45d4- 94bc- e0de277c4ff4</ ActivityLogUID>

DateTimeString> 2019- 06- 05 12: 16:24</ DateTimeString>
0fficerNbr2> 9999</ 0fficerNbr2>

Name>*** Accepted Recreation( Recreation)</ Name>

BookingNbr> IN201800017</ BookingNbr>

Location> Recreation</ Location>

LocationlD> 5140</ LocationlD>

Type> Section</ Type>

Code> OTCL</ Code>

EventDescription> Recreation</ EventDescription>

InsertDateString> 2019- 06- 05 12: 16: 58</ InsertDateString>
SSN> 414958</ SSN>

EventLogEntry>
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GUARDIAN RFID

REQUIREMENTS

In order to create this interface you will need:

1. SOAP API tool such as

2. EncryptionSerialization. dll which provides serialization and encryption classes

LICENSE

This interface is not licensed, however GUARDIAN RFID does charge a fee for supporting the" 1MS Receives
Data From GUARDIAN RFID" interface build. Some 1MS providers will also charge a fee. Please contact your 1MS
provider and GUARDIAN RFID account executive to ensure that this service was purchased.
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Outlook.

Re: GUARDIAN RFID I Quote for Rains County Sheriff's Office (TX)

From Jeff Kovar < jeffkovar@guardianrfid. com>

Date Tue 6/ 24/ 2025 3: 57 PM

To George Hernandez < george. hernandez@co. rains. tx.us>

lIIJ 3 attachments( 6 MB)

GUARDIAN RFID WiFi Configuration Guide. pdf; Hard Tag- Installation Guide. pdf; GUARDIAN RFID Interface Documentation
v6. 5. pdf;

Lt. Hernandez,

I have attached a copy of our WIFI configuration guide, as well as a copy with the interface guide.

Please share these guides with your IT and let me know if you have any questions.  I also shared a hard
tag installation guide that goes over the recommended types of screws to use when installing hard

tags. Hard tag installation is the agency's responsibility.

I would be more than happy to come out and tour the facility to identify hard tag locations. I can also
prepare the contract and send it over. Once the contract is signed, I will loop in our implementation
team, and they will work with you and your IT to build the website and configure the system for you.

If you want me to come onsite for the hard tag walkthrough, please let me know.  I am available this
Thursday or Friday, in the afternoon.  It should not take more than 30 minutes. Thank you.

Regards,

Jeff

Contact photo Jeff Kovar > Regional Sales Manager- East

GUARDIAN
P:  832- 833- 9126

RFID Logo

M: 832- 833- 9126

E:  jeff.kovar(a?guardianrfid.com
W: hops:// guardianrfid. com

YouT „ Linke yFaceb  -. Instagr Twit

ube din ook am ter

NOTICE: This message( including any attachments) from GUARDIAN RFID may contain information that is CONFIDENTIAL and/ or PROPRIETARY,
or protected by intellectual property laws such as copyright. If you are not an intended recipient, this notice is to inform you that any
dissemination of this message is strictly prohibited. If you have received this message in error, please do not read, copy, print, or forward this
message. Please permanently delete all copies and any attachments and notify the sender immediately. WARNING: Although the company has
taken reasonable precautions to ensure no viruses are present in this email, the company cannot accept responsibility for any loss or damage
arising from the use of this email or attachments.



On Tue, Jun 24, 2025 at 1: 13 PM George Hernandez < george: hernandez aC co rains: tx. us> wrote:

I have been given authority to move forward on this. Can we schedule a date to have you come out
and check the configuration and start the process.

Thank you

Get Outlook for iOS

From: Jeff Kovar< jeff.kovar( a?guardianrfid. com>

Sent: Friday, May 23, 2025 8:45: 58 AM

To: David Rojo< david. rojgco. rains, tx,us>

Cc: George Hernandez< george. hernandezC@co. rains. tx. us>; Ashley Hobbs< ashley.hobbs ahco. rains.tx.us>

Subject: GUARDIAN RFID J Quote for Rains County Sheriff' s Office ( TX)

Chief Rojo,

It was nice to have the opportunity to meet with you and your team yesterday.  I have attached
several documents to this email, including a copy of your quote.  In summary:

Quote Summary

Subscription Purchase ( includes device replacements at the end of the 3- year warranty period)
Year One:  $ 4, 218. 70

Annual SRF:  $ 3, 995.00

Summary of Attachments

1)  Quote for Subscription Purchase Pricing- This document shows an itemized list of the hardware,
software, and services you will receive. The devices come with a 3 year warranty. Subscription
Pricing includes device replacements at the end of the 3 year warranty at no additional cost
excluding shipping).

2) WIFI Configuration Guide- This document goes over the WIFI requirements.
3)  Hard Tag Installation Guide- This document provides recommendations on how to install the
hard tags.

4)  Implementation Process Guide- This document gives an overview of the implementation process.

Next Steps

1)  Review this email and all attachments.  If changes need to be made to any of the hardware
quantities, please let me know.
2)  Review the WIFI Configuration guide with your IT. Also, let your IT know we will need a one- way
interface with your JMS. Agencies can interface with our platform using our REST API or via SFTP.  If
your IT has access to the JMS data, they should be able to utilize our REST API to build the interface,
and there is no additional cost for this.  If your IT decides to interface via SFTP, you would need to
consult with your JMS representative, as they may charge a fee for access to your JMS data for your
SFTP interface. Any fees charged by your JMS vendor would be the agency' s responsibility.



3) You may review the hard tag installation guide so you are aware of what the installation process
will entail. We will ship you the hard tags already programmed and labeled, but it will be the
agency' s- responsibility to install thehard- tags. Once they are installed we will walk you through
testing of the system.
4)  If and when you are ready to move forward, let me know, and I will send you a formal contract.
Once the contract is signed and returned to me, I will introduce our project management team. At

that time, someone from project management will reach out to you and schedule your
implementation kick off call. They will be your main point of contact during implementation and will
schedule your onsite go- live training.
5)  Once your onsite training is completed, you will be considered " live" with our system. At that
time, you will be assigned an account manager who will check in with you periodically and make
sure you are happy with our platform.

If you have any questions at all, please let me know. Thanks again for your time!

Regards,

Jeff

Contact photo Jeff Kovar > Regional Sales Manager- East

GUARDIAN
P:  832- 833- 9126

RFID Logo

M: 832- 833- 9126

E:  jeff.kovar(@guardianrfid. com
W: https:// guardianrfid.com

NOTICE: This message( including any attachments) from GUARDIAN RFID may contain information that is CONFIDENTIAL and/ or PROPRIETARY,
or protected by intellectual property laws such as copyright. If you are not an intended recipient, this notice is to inform you that any
dissemination of this message is strictly prohibited. If you have received this message in error, please do not read, copy, print, or forward this
message. Please permanently delete all copies and any attachments and notify the sender immediately. WARNING: Although the company has
taken reasonable precautions to ensure no viruses are present in this email, the company cannot accept responsibility for any loss or damage
arising from the use of this email or attachments.



CARDIAC LIFE PRODUCTS

850 Saint Paul Street, Ste 44 Cardiac LifeRochester, NY 14605-1065

15852677775 empowering you to save lives
www. cardiaclife. net

Estimate

ADDRESS SHIP TO ESTIMATE 2797

Rains County- TX Rains County- TX DATE 06/ 27/ 2025

Accounts Payable Lori Northcut EXPIRATION 07/ 27/ 2025

220 W Quitman Street Suite B 220 W Quitman Street Suite B DATE

Emory, TX 75440 Emory, TX 75440

PREPARED BY SALES REPRESENTATIVE

CT CT

DATE DESCRIPTION QTY RATE AMOUNT

A-M5066A_ C01 Philips OnSite with Standard Carry 1 1, 219. 70 1, 219. 70

Case. Includes: Battery, SMART Pads
Cartridge, and Owners Manual. 8 Year

Warranty. New product code:
861282_ C01.

CPR- RR- Kit- Red Red Rescue Ready Kit Includes: CPR 1 15. 95 15. 95

Mask, Gloves, Medical Prep Razor,
One- Way Valve, Emergency Shears,
and Antiseptic Towelette.

Comphmentary ShippIng TOTAL 1, 235.65

Accepted By

Accepted Date

Estimate is valid for 30 days

There is a 2°,10 service charge for credit card transactions

Page 1 of 1





CARDIAC LIFE PRODUCTS

850 Saint Paul Street, Ste 44 Cardiac LifeRochester, NY 14605- 1065

15852677775 empowering you to save lives
www. cardiaclife. net

Estimate

ADDRESS SHIP TO ESTIMATE 2798

Rains County- TX Rains County- TX DATE 06/ 27/ 2025

Accounts Payable Lori Northcutt EXPIRATION 07/ 27/ 2025

220 W Quitman Street Suite B 220 W Quitman Street Suite B DATE

Emory, TX 75440 Emory, TX 75440

PREPARED BY SALES REPRESENTATIVE

CT CT

DATE DESCRIPTION QTY RATE AMOUNT

A- G5A- 80C- S Cardiac Science G5 AED, Fully-       1 1, 652. 87 1, 652. 87

Automatic with ICPR. Includes: Battery,
ICPR Electrode, Carry Sleeve, AED
Manager, USB Cable, and User Guide.

6 year warranty and 2 additional years
after registration with ZOLL.

CPR- RR- Kit- Red Red Rescue Ready Kit. Includes: CPR 1 15. 95 15. 95

Mask, Gloves, Medical Prep Razor,
One- Way Valve, Emergency Shears,
and Antiseptic Towelette.

Cornpianemary ShippIng TOTAL 1, 668. 82

Accepted By

Accepted Date

Estimate is valid for 30 days

There is a 2°/ 0 service charge for credit card transactions

Page 1 of 1





CARDIAC LIFE PRODUCTS

Cardiac T       (LifVRochester, NY 14605- 1065

15852677775 empowering you to save lives
www.cardiaclife. net

Estimate

ADDRESS SHIP TO ESTIMATE 2799

Rains County- TX Rains County- TX DATE 06/ 27/ 2025

Accounts Payable Lori Northcutt EXPIRATION 07/ 27/ 2025

220 W Quitman Street Suite B 220 W Quitman Street Suite B DATE

Emory, TX 75440 Emory, TX 75440

PREPARED BY SALES REPRESENTATIVE

CT CT

DATE DESCRIPTION QTY RATE AMOUNT

A-ZOLL- 8000- 004007- 01 ZOLL AED Plus, Fully- Automatic.     1 1, 629. 48 1, 629. 48

Includes: CPR- D Adult Padz, Pack of

10 Batteries, Carry Case, and Owner' s
Manual. 7 year warranty after
registration with ZOLL.

Compi mentary Shipping
TOTAL 1, 629. 48

Accepted By

Accepted Date

Estimate is valid for 30 days

There is a 2% service charge for credit card transactions

Page 1 of 1
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AUTOMATED EXTERNAL DEFIBRILLATORS  ( AEDS )     -

BATTERIES  &   ELECTRODES .     •

CABINETS  &  SIGNS

FOR CPR/ FIRST AID/ MISC .  ITEM REQU.EST.,

PLEASE CONTACT YOUR REPRESENTATIVE

585- 267- 7775
www.cardiaclife. net

850 Saint Paul Street
Suite 44     -     

Rochester, NY 14605

i

yam'


